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Preface

This guide describes how to use the Oracle RightNow adapter in your SOA composite
applications and Oracle Service Bus business services.

Audience
This guide is intended for anyone who is interested in using the Oracle RightNow adapter.

Related Resources
Refer to the Oracle Fusion Middleware library on the Oracle Help Center for additional
information.

• For Oracle SOA Suite information, see Oracle SOA Suite.

• For Oracle Service Bus information, see Oracle Service Bus.

• For adapters information, see On-Premises and Cloud SOA Adapters.

• For versions of platforms and related software for which Oracle products are certified and
supported, review the Certification Matrix.

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated with an
action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for which
you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code in
examples, text that appears on the screen, or text that you enter.
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1
Introduction to the Oracle RightNow Adapter

This chapter provides an introduction to the Oracle Cloud Adapter for Oracle RightNow Cloud
Service (the Oracle RightNow adapter).
This chapter includes the following topics:

• Introduction

• Overview

• Supported Versions and Platforms

Introduction
The Oracle RightNow adapter combines web, social tools, and contact center experiences for
a unified, cross-channel service solution in Oracle Cloud, enabling organizations to increase
sales and customer acquisition, build trust and strengthen relationships, and reduce costs
and effort. The RightNow Cloud Service enterprise platform provides transparent reliability,
unmatched security, and successful delivery of the mission-critical customer service and
support. It is a key component of the Oracle RightNow product family.

Today, there are thousands of enterprise customers across the globe and across different
industry verticals that use Oracle RightNow Cx for providing superior customer experience
across multiple channels including web, contact center, social and others.

These channels empower customers to easily self-solve issues from anywhere through the
web, collaborate support issues on products through social channels such as Facebook and,
most importantly, manage timely resolution of incidents across all channels.

To maximize ROI in SaaS assets, enterprises need to ensure that the data in their individual
SaaS and on-premise applications are accurate, up-to-date and integrated.

For example, enterprises can streamline operations and deliver real-time scheduling of field
technicians for services through Field Service integration with on-premise or SaaS
Applications such as E-Business Suite, TOA ETADirect and other integration with SaaS
applications such Oracle Sales Cloud or Salesforce.com can ensure that the enterprise sales
personnel have complete visibility into the customer experiences when they talk to their
customers and prospects. Similarly, integration with bug tracking applications such as Jira or
Bugzilla helps manage end-to-end resolution of customer-reported issues from start to finish.

Oracle RightNow Cx exposes various integration capabilities for desktop extensibility, data
integration and web integration. Data integration capabilities of Oracle RightNow Cx enable
real-time access and synchronization of data with other SaaS and on-premise applications.
Oracle RightNow Cx exposes a web services platform called Oracle Cloud Connect Web
Services for SOAP — a set of SOAP-based services that can be used to securely access and
modify data contained in the Oracle RightNow Cx platform. It is a backward-compatible,
public API that enables customers and partners to integrate with the Oracle RightNow Cx
platform using industry leading standards such as WSDL 1.1 and SOAP 1.1. It provides
broad support for a wide variety of languages, platforms, and tools.

The Oracle RightNow adapter leverages this web service platform to offer seamless
connectivity and simplified integration with the Oracle RightNow Cx. Using the Oracle
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RightNow adapter and the SOA Suite platform, customers can avoid high costs of
development, QA, maintenance and upgrades associated with developing custom
point to point integrations with other applications.

The Oracle RightNow adapter supports custom attributes (new RightNow concept
custom attributes and custom fields with the default c package) in business objects to
make use of the Oracle RightNow application’s support for custom attributes. Note the
following details:

• Custom attributes and custom fields are visible in a hierarchal structure in the
mapper. For example, assume you create an integration in which you select the
Contact business object on the Request page of the adapter configuration wizard.
If you then go to the mapper, and expand the Contact element, an element called
ContactCustomFields is displayed. If you expand this element, you see that
custom attributes are visible in a hierarchal structure in the tree. Custom attributes
are also visible as part of custom packages in the mapper.

• If you have a prebuilt integration from an earlier release of Oracle Integration
Cloud Service that contained business objects that now support custom attributes,
those attributes are now visible in the mapper after you regenerate the artifacts for
the integration. However, they are not displayed in a hierarchal structure, but
rather the flat structure of previous releases (not under any package).

• Custom attributes are also visible in the generated artifacts that you can download.

The Oracle RightNow adapter supports the RightNow Object Query Language
(ROQL), which supports querying data using QueryCSV. This enables you to retrieve
data in a tabular format.

Overview
The Oracle RightNow adapter builds on the Connect Web Services API for SOAP to
provide real-time integration with the Oracle RightNow Cx Platform. RightNow API
version 1.3 is supported. The Oracle RightNow Connect Web Services platform
exposes two web service definitions (WSDLs) to calling applications.

• Standard WSDL. This WSDL should be used by integration designers to model
integrations specific to their Oracle RightNow instance. The typed WSDL is a
strongly typed representation of the Connect Common Object Model. The strongly
typed WSDL can be accessed from the following URL with a standard HTTP GET
request. The standard WSDL can include support for both business objects and
event subscriptions. This enables you to receive either a business object or an
event subscription as a request from the Oracle RightNow application. Event
subscriptions are supported only if the Oracle RightNow application version is
equal to or greater than version 15.5 (May 2015 release). Otherwise, only
business objects are visible for selection in the configuration wizard.

<a target="_blank" href="http://">http://</a><host_name>/cgi-bin/
<interface>.cfg/services/soap?wsdl=typed

Because the Standard WSDL is tied to a specific Oracle RightNow Cx Instance for
an Organization, it will change if modifications or customizations are made to the
instance configuration.

• Partner WSDL. This WSDL should be used by integration designers building
integrations that function across multiple instances of Oracle RightNow Cx. It
provides the ability to work with generic objects that can be used across multiple
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instances of Oracle RightNow. The generic WSDL can be accessed from the following
URL with a standard HTTP GET request.

<a target="_blank" href="http://">http://</a><host_name>/cgi-bin/<interface>.cfg/
services/soap?wsdl=generic

Since the WSDL is static and does not change across organizations, it will not have any
customizations or modifications made to the Organization's specific RightNow Cx
instance. It is used primarily by Partners, hence the name Partner WSDL.

The Oracle RightNow adapter enables customers to perform integration with a specific
Oracle RightNow Cx instance through the Standard WSDL However, Partner WSDL-
based integration is currently unsupported.

The Standard WSDL exposes categories of operations, including:

• Basic CRUD Operations (Create, Get, Update, Destroy Business Objects in RightNow)

• ROQL (Query data in RightNow as objects only)

• Batch Operation (a batch of one or more of the other operations in one operation)

The above operations, more specifically the CRUD Operations, are polymorphic in nature.
Though this might appear to simplify the integration interface by needing to expose just four
generic CRUD operations (Create, Get, Update and Destroy) across all supported business
objects in the application, it also poses challenges during the integration process, especially
during data mapping. For more information, see Understanding BPEL Integration with
Service Components (BPEL/Mediator) and Developing Oracle Service Bus Integrations with
the Oracle RightNow Adapter.

Example 1-1 shows a RightNow Standard WSDL with generic CRUD operations shown.

Example 1-1     Generic CRUD Operations in a RightNow Standard WSDL

<wsdl:operation name="Create">
                   <wsdl:input message="rnw_v1_2:CreateRequest"/>
               <wsdl:output message="rnw_v1_2:CreateResponse"/>
               <wsdl:fault message="rnw_v1_2:RequestErrorFault" 
name="RequestErrorFault"/>
               <wsdl:fault message="rnw_v1_2:ServerErrorFault" 
name="ServerErrorFault"/>
               <wsdl:fault message="rnw_v1_2:
          UnexpectedErrorFault"name="UnexpectedErrorFault"/>
        </wsdl:operation>
        <wsdl:operation name="Get">
               <wsdl:input message="rnw_v1_2:GetRequest"/>
               <wsdl:output message="rnw_v1_2:GetResponse"/>
               <wsdl:fault message="rnw_v1_2:RequestErrorFault" 
name="RequestErrorFault"/>
               <wsdl:fault message="rnw_v1_2:ServerErrorFault" 
name="ServerErrorFault"/>
               <wsdl:fault message="rnw_v1_2:
       UnexpectedErrorFault"   name="UnexpectedErrorFault"/>
</wsdl:operation>
        <wsdl:operation name="Get">
              <wsdl:input message="rnw_v1_2:GetRequest"/>
              <wsdl:output message="rnw_v1_2:GetResponse"/>
              <wsdl:fault message="rnw_v1_2:RequestErrorFault" 
            name="RequestErrorFault"/>
              <wsdl:fault message="rnw_v1_2:ServerErrorFault" 
            name="ServerErrorFault"/>
              <wsdl:fault message="rnw_v1_2:
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     UnexpectedErrorFault" name="UnexpectedErrorFault"/>
        </wsdl:operation>
          <wsdl:operation name="Update">
              <wsdl:input message="rnw_v1_2:UpdateRequest"/>
              <wsdl:output 
message="rnw_v1_2:UpdateResponse"/>
                <wsdl:fault message="rnw_v1_2:RequestErrorFault" 
name="RequestErrorFault"/>
                <wsdl:fault message="rnw_v1_2:ServerErrorFault" 
name="ServerErrorFault"/>
                <wsdl:fault message="rnw_v1_2:UnexpectedErrorFault" 
name="UnexpectedErrorFault"/>
        </wsdl:operation>
        <wsdl:operation name="Destroy">
               <wsdl:input message="rnw_v1_2:DestroyRequest"/>
            <wsdl:output message="rnw_v1_2:DestroyResponse"/>
               <wsdl:fault message="rnw_v1_2:RequestErrorFault" 
name="RequestErrorFault"/>
               <wsdl:fault message="rnw_v1_2:ServerErrorFault" 
name="ServerErrorFault"/>
               <wsdl:fault message="rnw_v1_2:
      UnexpectedErrorFault" name="UnexpectedErrorFault"/>
        </wsdl:operation>

RightNow Object Query Language (ROQL pronounced "Rockwell") provides a query
subsystem that enables clients of the API to perform SQL-like queries against the
Oracle RightNow Cx platform. The language evolved from Object Query Language
(OQL), a query language standard developed by the Object Data Management Group
(ODMG) for object-oriented databases modeled after SQL.

ROQL supports querying objects only. QueryObject enables calling applications to
retrieve data as a list of objects.

Example 1-2    ROQL Query Example to Retrieve Details of an Incident with a
Specific ID

select Incident from Incident I where I.ID=102345

The Oracle RightNow adapter exposes the capabilities defined in the Standard WSDL
in a simpler graphical object-operation view hiding the complexities of the interface
from the integration modeler. In contrast to the polymorphic interface definition, the
Oracle RightNow adapter generates a strongly-typed service operation from the
design-time configuration. This significantly simplifies the data mapping exercise.

Prerequisites to Using the Oracle RightNow Adapter
The following are the prerequisites for you to start modeling integrations using the
Oracle RightNow adapter with either the SOA Suite or Oracle Service Bus.

In addition to these prerequisites, you must ensure that you have the correct
supported version of the SOA Suite and the Oracle Service Bus. For information on
supported versions and platforms, see the release certification matrix at http://
www.oracle.com/technetwork/middleware/ias/downloads/ fusion-
certification-100350.html.

• Obtain the standard WSDL. For more information on the Standard WSDL, see
the Oracle RightNow Connect Web Services for SOAP Developer Guide "WSDL
Retrieval."
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• Ensure you have valid RightNow Cx credentials. For more information, refer to the
section "Oracle Cloud Adapter for Service Cloud Connection Parameters," in the Oracle
RightNow Connect Web Services for SOAP Developer Guide.

• Obtain client certificates. For more information, refer to "Service Cloud Certificate into
Client/Server," in the Oracle RightNow Connect Web Services for SOAP Developer
Guide.

Oracle RightNow Adapter Design Overview
The Oracle RightNow adapter can have multiple adapter instances. An adapter instance is
basically a configured Oracle RightNow adapter, which can connect with the RightNow CX
Server and invoke the RightNow Cx cloud operation which you have selected during
configuration.

Each adapter instance has its own artifacts, for example, Integration WSDL and JCA file.

Because each adapter instance points to a single RightNow Cx cloud operation, there is a
one-to-one correspondence from adapter instances to RightNow Cx cloud operations. For the
list of supported operation, see Understanding Create, Read, Update, and Delete Operations.

The adapter instances are part of the SOA composites. Each time the adapter wizard is run,
it creates one instance of the Oracle RightNow adapter.

An Oracle RightNow adapter instance consists of a JCA file, a WSDL, and a reference
element added to the composite.xml.

The Oracle RightNow adapter supports RightNow making outbound synchronous calls from
the Oracle SOA Suite.

The Oracle RightNow adapter runtime framework uses the artifacts generated in the above
steps.

Table 1-1 shows the adapter configuration wizard-generated SOA composite adapter
artifacts, together with notes.

Table 1-1    Oracle RightNow Adapter Artifacts

Artifact Notes

rightnowReference.wsdl The Oracle RightNow adapter supports Standard WSDL only.

<serviceName>_rightnow.j
ca

The JCA file contains the internal implementation details used by the
adapter during run-time. It contains the different interaction and
connection properties used by the adapter. The operations describe
the action that must be taken against the end point, such as Create,
Update, etc. The contents of the file are determined by choices made
during the Adapter Configuration.

Supported Versions and Platforms
For information on supported versions and platforms, see the release certification matrix at
http://www.oracle.com/technetwork/middleware/ias/downloads/ fusion-
certification-100350.html.
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WSDLs Supported by Oracle RightNow Adapter
The Oracle RightNow adapter supports the Standard WSDL only. There is no support
for the Partner WSDL. The API version which the RightNow adapter supports is 1.3.
See also Obtaining the Standard WSDL.

For more information on the Standard WSDL, see "WSDL Retrieval" in the Oracle
RightNow Connect Web Services for SOAP Developer Guide, Getting Started:
Introduction to Connect to Web Services.

Chapter 1
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2
Getting Started with the Oracle RightNow
Adapter

This chapter explains how to get started with the Oracle RightNow adapter. For information
on running specific use cases once you have prepared the design time and run time features
of the Oracle RightNow adapter, see Oracle RightNow Adapter Use Cases.
It provides information on quickly getting started with the Oracle RightNow adapter and
contains the following sections:

• Using Oracle RightNow Adapter Connection Parameters

• Obtaining the Standard WSDL

• Understanding the Oracle RightNow Adapter in Design Time and Runtime

• Unsupported Features

Using Oracle RightNow Adapter Connection Parameters
This section describes the Oracle RightNow adapter connection parameters that enable you
to perform operations on business objects

The Oracle RightNow adapter requires your login credentials to enable you to begin using the
Oracle RightNow adapter configuration wizard.

The required connection parameters are:

• Username

• Password

• Authentication key, or Credential Store Framework (CSF) key. This is a key you use to
inject runtime credentials. The adapter uses the CSF key to retrieve the username and
password required for RightNow authentication. This key identifies a user's Oracle
RightNow CX login credentials during design time. During runtime, the key is
automatically created while deploying the SOA composite application to the server.
oracle.wsm.security. The CSF key rules work as follows:

– If the CSF key credentials do not exist, then create them.

– If the CSF key credentials already exist, do not overlay them. This causes an error
during deployment.

– If the CSF key credentials already exist, the deployment credentials are compared
with the credentials on the server. If they do not exactly match, an exception occurs
and deployment fails. You must manually modify the CSF key, and retry deployment.

See Credential Store Configuration for Managing RightNow Credentials for more
information.

• For additional information, see Authenticating on the Oracle RightNow Cx Server with
Account Passwords.
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Obtaining the Standard WSDL
To obtain the standard WSDL for use with the RightNow adapter:

1. Collect the following details from your Oracle RightNow Cx Account:

• – Host

– Interface name

– Username and password

2. Open your web browser and enter the following URL to obtain the Standard
WSDL, replacing the host name and interface details as appropriate.

https://<host_name>/cgi-bin/<interface>.cfg/services/soap?wsdl=typed

For example:

https://integration-test.rightnowdemo.com/cgi-bin/integration_test.cfg/
services/soap?wsdl=typed

Note:

Permissions for Public SOAP API must be enabled for the user account
to enable use of the Oracle RightNow Connect Web Services for SOAP
API.

Permissions for Public SOAP API enable staff members with this profile
to access the public SOAP API through account or session
authentication.

The Oracle RightNow adapter does not support the partner WSDL/generic WSDL.
Therefore, the following URL is not supported:

http://integration-test.rightnowdemo.com/cgi-bin/integration_test.cfg/
services/soap?wsdl=generic

Importing the Oracle RightNow Application's Certificate into the Client/
Server

To import the Oracle RightNow adapter certificate into the client/server:

1. Open your web browser and type the following URL, replacing the host_name and
interface details.

https://<host_name>/cgi-bin/<interface>.cfg/services/soap?wsdl=typed

An example is:

http://integration-test.rightnowdemo.com/cgi-bin/integration_test.cfg/
services/soap?wsdl=typed

Where host_name is integration-test.rightnowdemo.com and interface is
integration_test

Chapter 2
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2. Click the lock icon, as shown in Figure 2-1.

Figure 2-1    The Lock Icon in the Browser Window for Internet Explorer Browser

Figure 2-2 shows the location of the lock icon in the Chrome Browser.

Figure 2-2    Location of Lock Icon in Chrome Browser Indicated by Arrow

Figure 2-3 shows the location of the lock icon in the Mozilla Firefox browser.

Figure 2-3    Location of Lock Icon in Mozilla Firefox Browser Indicated by Arrow

A small window pops up. Click View certificates, at the bottom of the pop-up, as shown
in Figure 2-4.
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Figure 2-4    View Certificates in Pop-up

3. After clicking View Certificates, another window is displayed, providing the details
of the certificate. Open the Details tab and click Copy to File, as shown in 
Figure 2-5.
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Figure 2-5    Certificate Details Pop-up

4. The Windows Certificate export wizard opens. Click Next and select Base-64 encoded
X.509 (.CER) option, See Figure 2-6.
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Figure 2-6    The Certificate Wizard, with Base-64 encoded X.509m(.CER)
Selected

5. Click Next and browse to the location where you want to save the certificate.
Provide an appropriate name to the certificate file and save it. For example, you
can copy the certificate, say rightnowdemo.crt to the folder, FMW_HOME/wlserver/
server/lib.

6. Import the downloaded certificate into your application server, and configure your
application server to request the client certificate. Re-import the certificate in case
certification expiration has occurred.

Importing the Oracle RightNow Application's Public Certificate into
WebLogic Server Using Keytool

You must import the Oracle RightNow application's public certificate into Oracle
WebLogic Server using the keytool.

Before you follow the steps for importing, ensure that parameter Hostname
Verification field (under the tab SSL in the console) is set to NONE on the server side.

To import the Oracle RightNow adapter's public certificate into the Oracle WebLogic
Server keytool:

1. Provide a suitable location on your system to save the certificate authority. Mark it
as trusted. Save it on a suitable location on your system.

Chapter 2
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2. To find the WebLogic server's trust keystore location, log in to the admin console http://
url:port/console/

3. On the home page, proceed to Servers under Environment subsection.

4. Select the Admin server from the list of servers displayed.

5. Proceed to the Keystores tab, as shown in Figure 2-7.

Figure 2-7    The Keystores Tab

6. Under the Keystores tab, select the Demo Trust Keystore path. This is the path where
the keystore resides.

The path is similar to {Middleware_Home} \wlserver_10.3\server\lib.

7. Import this certificate from the authority into WebLogic server's trust store. If you are
using Windows, use the command prompt or if you're using Unix/Linux, use your
command shell and navigate to the path mentioned above.

8. Once at the path where the keystore resides, run the following keytool command:

keytool -import -trustcacerts -alias OracleRightNowCA -file <Filename with 
location> -keystore DemoTrust.jks -storepass DemoTrustKeyStorePassPhrase 

For example, assuming you keep the downloaded certificate at the location as mentioned
in Step 7 and the name of the certificate is OracleServiceCloudCA.cer, the keytool
command you use is similar to:

keytool -import -trustcacerts -alias OracleRightNowCA -file 
OracleServiceCloudCA.cer -keystore DemoTrust.jks -storepass 
DemoTrustKeyStorePassPhrase

9. A message that the certificate was added to keystore is displayed, which confirms your
successful import of the certificate. When prompted if you can trust this certificate, enter
Yes and select Enter.

10. You can verify that the certificate was added to the keystore by listing all certificates using
the following command:

keytool -list -keystore DemoTrust.jks -storepass DemoTrustKeyStorePassPhrase 

The newly imported certificate appears as part of existing certificates in the keystore.

11. Restart the server to bring modifications made in the previous steps into effect.

Configuring Oracle RightNow Adapter Permissions
To configure permissions to enable you to make calls for CRUD operations and query
operations:
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1. Install Oracle RightNow CX client.

2. Log in to Oracle RightNow CX client, See the Oracle RightNow CX User Guide.

3. Navigate to Staff Management, and then click Profiles

4. Select the Profile, the user account that must be enabled.

5. Click the Permissions tab.

6. Check Select All for Public SOAP API.

7. Check Account Authentication under Public SOAP API.

8. Select object-specific permissions from object-specific tabs. See the next section.

Details for Object-specific Permissions
See Table 2-1 for information on these permissions. See the Oracle RightNow CX
Cloud Service Server August 2014 User Guide for additional information.

Table 2-1    Finding Information on Objects

Information on... Can be found in this location in the Oracle RightNow Cx
User Guide

Organization Permissions Navigate to Core Features -->Staff Management--
>Customizing Profiles --> Organization Permissions

Contact Permissions Navigate to Core Features --.>Staff Management
--.>Customizing Profiles --.>Contact Permissions

Service Permissions Navigate to Core Features --.>Staff
Management--.>Customizing Profiles ' Service Permissions

Opportunity Tracking
Permissions

Navigate to Core Features--.>Staff Management --.>
Customizing Profiles--.>Opportunity Tracking Permissions

Custom Object Permissions Navigate to Core Features--.>Staff
Management--.>Customizing Profiles --.>Custom Object
Permissions

For related permissions information, specifically, information on RightNow CX IP
Address Range and Restrictions, see the Oracle RightNow Cx Server May 2013
Release Notes.

Authenticating on the Oracle RightNow Cx Server with Account
Passwords

The following section provides information on authenticating on the Oracle RightNow
Cx Server with account passwords.

Oracle Cloud Connect Web Services for SOAP API Access Control
When the Oracle Cloud Connect Web Services for SOAP API receives a request, a
series of access control measures are enforced:

1. The site configuration is checked to ensure the API has been enabled at a site
level.

2. The user credentials supplied in the request are validated

Chapter 2
Obtaining the Standard WSDL

2-8



3. The profile for the supplied account is checked to ensure the correct profile bit is enabled.
The profile is the mechanism for controlling access to administrative functions and for
assigning staff members specific permissions, default workspaces, a default navigation
set, and report access.

Note:

Server-side access control is enforced on all core API calls made by Oracle
Cloud Connect Web Services for SOAP. The current permissions map to read,
edit, delete, and move check boxes on the Profile Permissions editor in Oracle
RightNow. Although server-side access is enabled by default on new May 2013
sites and later, it is disabled on upgraded sites before the May 2013 release. If
you are an existing Oracle RightNow customer and plan to upgrade your site to
a May 2013 or later build, contact customer care to have this security-
enhancing functionality enabled.

If you already have server-side access control enabled on your site, be careful
of changes you make to Profile permissions. If an Oracle RightNow
administrator changes the permissions on a profile for a specific Oracle Cloud
Connect Web Services for SOAP integration, such changes might break that
integration.

Understanding the Oracle RightNow Adapter in Design Time
and Runtime

This section provides an overview that enables you to access the Oracle RightNow adapter in
both design time and runtime.

The Oracle RightNow adapter has two components:

• Design time. The design-time component of the Oracle RightNow adapter is the
configuration wizard. The wizard enables generation of artifacts that are needed to invoke
and consume Web services. It consists of configuration windows that create the artifacts
needed to communicate with the RightNow Cx.

Oracle JDeveloper design time for the Oracle RightNow adapter provides the user
interface that facilitates creating an on-premise connector/adapter to the RightNow Cx. It
supplies the following features:

– Ability to input the RightNow Cx WSDL on which the connection is to the RightNow
Cx is to be made.

– Validation of the RightNow Cx WSDL together with its associated CSF key.

– Testing the Oracle RightNow connection for success.

– Browsing standard objects or event subscriptions that are available to you in
RightNow CX.

– Enabling you to select/query the RightNow CX business objects in two ways:

* Ability to use the shuttle-based business object browser widget.

* Ability to test and validate the ROQL query during design time.
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The flowchart shown in Figure 2-8 explains the complete design-time lifecycle-
(the actions you perform in configuring the Oracle RightNow adapter). It shows the
Adapter Configuration Wizard for the runtime and how the design time relates to
its SOA context.

Figure 2-8    Oracle RightNow Adapter Design Time Flowchart

• The adapter also has a runtime component. You use the runtime part of the
adapter for delivering the information generated during design time to the service
endpoint. This is where the invocation of the Web Service occurs.

You can install the Oracle RightNow adapter for both new and existing customers of
Oracle SOA Suite 12.2.1.

Unsupported Features
The adapter does not support the following features:

• Adapter runtime retry configuration properties such as jca.retry.count,
jca.retry.backoff, jca.retry.interval, and jca.retry.maxInterval.

• Message recovery in the Error Hospital in Oracle Enterprise Manager Fusion
Middleware Control.

• The display of properties in the Properties tab for a reference (outbound) adapter
in Oracle Enterprise Manager Fusion Middleware Control (for example, service
WSDL URL, CSF key used, and others). These are the reference adapters that
you select on the Services and References page.
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• Rejected message handling

• Metrics such as the number of invocations.

• The following message encryption and decryption features available when you right-click
a cloud adapter in the Exposed Service swimlane or External References swimlane in
Oracle JDeveloper:

– Protect Sensitive Data > Encrypt Request Data for cloud adapters in the Exposed
Service swimlane.

– Protect Sensitive Data > Decrypt Sensitive Data for cloud adapters in the External
References swimlane.

• The policy attachments feature available when you right-click a cloud adapter in the
Exposed Service swimlane or External References swimlane in Oracle JDeveloper.
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3
Walkthrough of the Oracle RightNow Adapter
Configuration Wizard

This chapter describes common configuration steps for the Oracle RightNow adapter using
Oracle JDeveloper, various operations available with the adapter that are related to create,
read, update and delete, features available with those operations, and use of the RightNow
Object Query Language (ROQL) query language.
The chapter includes the following sections:

• Performing Common JDeveloper Configuration Steps

• Understanding Create, Read, Update, and Delete Operations

• Working with ROQL

Many of the sections summarize the operation or option and point to other chapters where
the information is discussed in more depth.

Performing Common JDeveloper Configuration Steps
This section provides a summary of the common configuration steps for beginning an Oracle
RightNow adapter project using Oracle JDeveloper. While you can use Oracle JDeveloper to
configure an Oracle RightNow adapter and create a BPEL project, you can also configure the
adapter for use with other service engines, such as Oracle Service Bus.

Creating a SOA Application Project in JDeveloper
To configure an Oracle RightNow adapter for use as an outbound or inbound service using
Oracle JDeveloper, first create the SOA application project.

1. Click New and select Application from the File menu of Oracle JDeveloper.
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Figure 3-1    Navigation

2. The New Gallery page is displayed. Select SOA Application from the Items list.

Figure 3-2    Create SOA Application
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3. Provide a suitable name to your application.

Figure 3-3    Name Your Application

4. Click Next and provide a suitable name to your project.
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Figure 3-4    Providing a Name for Your Project

5. Click Next.

6. Select Standard Composite.

7. Select Composite with BPEL Process.
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Figure 3-5    Configuring SOA Settings

8. Click Finish.

The SOA composite application is displayed for designing in the SOA Composite Editor.
Note that when dragging and dropping service and reference cloud adapters to the
Exposed Service and External References swimlanes, the following features are not
supported:

• The message encryption and decryption features available when you right-click a
cloud adapter in the Exposed Service swimlane or External References swimlane
in Oracle JDeveloper:

– Protect Sensitive Data > Encrypt Request Data for cloud adapters in the
Exposed Service swimlane.

– Protect Sensitive Data > Decrypt Sensitive Data for cloud adapters in the
External References swimlane.

• The policy attachments feature available when you right-click a cloud adapter in the
Exposed Service swimlane or External References swimlane in Oracle JDeveloper.

Configuring an Oracle RightNow Adapter for Inbound Services
To configure an Oracle RightNow adapter for use as an inbound service using Oracle
JDeveloper:

1. Drag and drop the Oracle RightNow adapter component from the Components in Oracle
JDeveloper to the Exposed Services swimlane.

2. Click the Oracle RightNow adapter icon in the swimlane. The Oracle RightNow adapter
Basic Info screen appears.
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3. Enter basic information to connect to the Oracle RightNow adapter.

Configure Example/Information

What do you want to call
your endpoint?

Enter a meaningful name.

What does your endpoint
do?

Enter a description.

4. Click Next. The Connection page appears.

 

 

5. Enter connection information.

Configure Example/Information

WSDL URL Obtain the WSDL from your RightNow administrator.

Security Policy Select a policy.

Authentication Key You can obtain the authentication key from your RightNow
administrator.

Test Test the connection to validate the credentials.

6. Click Next.

7. Select the business object or event subscription that you want to receive from
Oracle RightNow Cx as a request document to start this integration, then select
Next. The standard WSDL can include support for both business objects and
event subscriptions. This enables you to receive either a business object or an
event subscriptions as a request from the Oracle RightNow application. Event
subscriptions are supported only if the Oracle RightNow application version is
equal to or greater than version 15.5 (May 2015 release). Otherwise, only
business objects are visible for selection in the configuration wizard.

8. Select a response type and optional business object for the response.

• Select None if a response is not required.
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• Select Immediate, then select a business object that you want the integration to
send as a response document to Oracle RightNow Cx.

9. Click Next.

The Summary page is displayed.

10. Click Finish.

Configuring an Oracle RightNow Adapter for Outbound Services
To configure an Oracle RightNow adapter for use as an outbound service using Oracle
JDeveloper:

1. Drag and drop the Oracle RightNow adapter component from the Components list in
Oracle JDeveloper to the references swimlane.

2. Click the RightNow adapter icon in the swimlane. The Basic Info screen appears.

3. Enter basic information to connect to the Oracle RightNow adapter.

Configure Example/Information

What do you want to call
your endpoint?

Enter a meaningful name.

What does your endpoint
do?

Enter a description.

4. Click Next. The Connection page appears.
 

 

5. Enter connection information.

Configure Example/Information

WSDL URL Obtain the WSDL from your RightNow administrator.

Security Policy Select a policy.
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Configure Example/Information

Authentication Key You can obtain the authentication key from your RightNow
administrator.

Test Test the connection to validate the credentials.

6. Click Next. The RightNow adapter configuration wizard displays additional
information for you to select:

• The operation you want to perform.

• The objects against which you perform the operation.

• Any operation-specific configurations.

At this point, you can indicate to either perform single CRUD operations or perform
operations in a batch:

• Single Operation - Select this option to work with a single operation.

• Batch Operation - Select this operation to work with multiple operations.

The following figure shows the Operation screen in which you perform the
large part of your work related to selecting operations.

7. Click Next.

The Summary page is displayed.

8. Click Finish.

Understanding Create, Read, Update, and Delete
Operations

The operations available with the Oracle RightNow adapter include create, read,
update, and delete, or CRUD operations.

The CRUD operations enable the creation, reading, updating and deleting of objects
contained in the Oracle RightNow Cx system.

All CRUD operations behave in a polymorphic manner as defined in the Polymorphic
Behavior section. Therefore, any CRUD operation can accept as input parameters 1 to
N heterogeneous primary objects, which means a mix of object types can be supplied
to any CRUD operation in a single request.

For example, a Contact, Incident, and Organization object can be supplied to a single
invocation of the Create method.

There is a hard limit of 1000 objects that may be supplied in a single CRUD request –
however, due to operational constraints, supplying the maximum objects might result
in an error.

The return value of Create and Get (Read) is a list containing 1 to N RNObjects. The
size of the list will match the size of the list provided in the operation request. The
Update and Destroy methods do not return a value upon success. If a CRUD
operation fails, a SOAP fault is returned to the client.

However, the Create operation returns the ID of the created business object if you
have disabled suppressResponse but the Get operation returns the entire business
object.
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When a client of Oracle Cloud Connect Web Services for SOAP invokes a Create operation,
an object or list of objects will be returned. If you require the rest of the data associated with
the object, a Get operation must be performed.

The Create operation can be performed directly on all primary objects.

When a client of the Oracle Cloud Connect Web Services invokes a Get operation, an object
or list of objects is returned.

The Destroy operation destroys primary objects and sub-objects.

Supported Features
The following sections discuss the list of features supported by Oracle RightNow adapter.

• Using CRUD Operations

• Using the Batching Feature

• Chaining

• Using Chaining

Using CRUD Operations
The Oracle RightNow adapter supports CRUD, or create, read, update, and destroy
operations. The basic operations supported include the following:

• Creating One or Multiple Business Objects

• Retrieving Data from One or Multiple Objects

• Updating One or Multiple Business Objects

• Deleting one or Multiple Business Objects

Creating One or Multiple Business Objects

You create one or multiple business objects (standard or custom) on RightNow Cx using the
Oracle RightNow adapter. For example, you create Organization, Contact and Incident
objects all as part of a single request or as three independent requests.

For example, on the Operation screen, you can select the Organization, Contact, and
Incident objects as part of one request.

Retrieving Data from One or Multiple Objects

You can retrieve data either from one or multiple objects available on the RightNow CX cloud
platform using the Oracle RightNow adapter. For example, you can use the Oracle RightNow
adapter to retrieve data just related to just organizations or the information could be a
combination of organizations, contacts and incidents in one request.

For example, you can retrieve data from just Organization, by specifying the Get operation in 
Operations screen and selecting the Organization object.

1. Choose the Get operation from the Select an Operation Type list.

2. Use the arrow to move the Organization object from the Available list to the Selected
list.
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3. Click Next.

Updating One or Multiple Business Objects

Use the Update operation to update any primary object and associated subobjects.
You can update one or multiple business objects (standard or custom) on the
RightNow CX cloud platform using the . For example, you can update Organization,
Contact and Incident objects as part of a single request or as three independent
requests.

For example, you can update the Organization, Contact and Incident objects as part
of a single Update request on the Operation screen.

To perform an Update operation:

1. Select Update from the Select an Operation Type list.

2. Select one or more business objects from the Available list.

3. Use the arrows to move the business objects to the Selected list.

4. Click Next.

You can update one object as part of a series of updates to three objects.

Deleting one or Multiple Business Objects

You can delete one or multiple business objects (standard or custom) on the RightNow
Cx cloud platform using the Oracle RightNow adapter. For example, you can delete
Organization, Contact and Incident objects all as part of a single request or as three
independent requests.

In the following screenshot, you use the Oracle RightNow adapter Operation screen to
delete Organization, Contact, and Incident objects.

To delete multiple business objects:

1. Choose the Destroy operation from the Select an Operation Type list.

2. Use the arrow to move the Organization, Contact and Incident objects from the
Available list to the Selected list.

3. Click Next.

Using the Batching Feature
Batching is a unique feature of the Oracle RightNow adapter that enables one or more
heterogeneous operations to be sent to RightNow Cx server through a single
operation. This feature enables the integration developer to update an existing
organization, create a contact for an existing organization, delete a note for an existing
incident, or create a new incident. Using batching, all these instructions can be
consolidated and sent to Oracle RightNow Cx server as a single operation. The Oracle
RightNow adapter extends this capability by providing the necessary tooling to
configure batch operations and batching options.

The adapter also provides an integration-friendly interface for batch operations and
processing options. You can select the Batch Operation option to configure this
option.
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Other features of batching include:

• Each operation in a batch has separate processing options. The adapter configuration
wizard provides a graphical and intuitive way for users to configure the processing
options.

• Operations within a batch are normally executed in a single transaction, but these
operations can be grouped into different units of work using the commitAfter property.
This property groups multiple operations in a single transaction. At runtime, when a set of
operations in a batch are defined as part of a single operation, this action is sent after the
last operation in that transaction boundary.

Oracle RightNow Adapter User Interface Support for Batching

Batching is a unique feature of the Oracle RightNow adapter that allows one or more
operations to be sent to Oracle RightNow Cx through a single operation.

The Oracle RightNow adapter extends batching capability by providing the necessary tooling
to configure batch operations and batching options. It also provides an integration-friendly
interface for batch operations and processing options.

The following section describes how you can use the adapter configuration wizard to model
the Oracle RightNow adapter for batch operations:

1. In a SOA project or a service bus project, drag and drop the Oracle RightNow adapter
from Components to the composite swim lane. Provide a valid connection name.

2. Provide connection details.

 

 

3. In the Operations page, select the Batch Operation option to configure a batch
operation.

4. Selecting this option enables you to configure multiple operations in a batch.

5. You can then select and add an operation in the batch operation.

6. Once added, the operations appear listed with the appropriate business object.
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7. Each operation in a batch process has separate processing options that can be
specified in the Properties tab. For example, the Add Operation has three
properties you can specify: Suppress External Events, Suppress Rules, and
Commit After.

8. Select Next to complete the adapter wizard. The confirmation dialog shows the
generated artifacts.

Operations within a batch are normally executed in a single transaction; however,
these operations can be grouped into separate units of work using the commitAfter
property.

Batch Process WSDL

The following examples represent different parts of a sample WSDL from a batch
process. The first example shows the port type and operation defined within the
integration WSDL for the batch operation:

Example 3-1    PortType and Operation

<wsdl:portType name="rightnowReferencePortType">
        <wsdl:operation name="Batch">
            <cloud:CloudOperation xmlns:cloud="http://xml.oracle.com/types" 
targetOperation="Batch"/>
            <wsdl:input message="ns0:BatchRequestMessage"/>
            <wsdl:output message="ns0:BatchResponseMessage"/>
            <wsdl:fault name="ServerErrorFault" 
                     message="ns0:ServerErrorFault"/>
            <wsdl:fault name="RequestErrorFault" 
                     message="ns0:RequestErrorFault"/>
            <wsdl:fault name="UnexpectedErrorFault" 
message="ns0:UnexpectedErrorFault"/>
        </wsdl:operation>
</wsdl:portType>

The second example shows the input message type defined in the Integration WSDL
Batch operation.

Example 3-2    Input Message Type Defined in Integration WSDL Batch
Operation:

<xs:element name="Batch" type="ns2:BatchRequestType"/>
<xs:complexType name="BatchRequestType">
                <xs:sequence>
                    <xs:element name="Create" 
                             type="ns2:CreateRequestType"/>
                    <xs:element name="Update" 
                            type="ns2:UpdateRequestType"/>
                    <xs:element name="Get"
                            type="ns2:GetRequestType"/>
      </xs:sequence>
</xs:complexType>
 
<xs:complexType name="CreateRequestType">
      <xs:sequence>
<xs:element maxOccurs="unbounded" minOccurs="0" type="ns7:Account" 
name="Account"/>
</xs:sequence>
</xs:complexType>
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The next example shows the output message type defined in the integration WSDL Batch
operation.

Example 3-3    Output Message Type Defined in Integration WSDL Batch Operation:

<xs:element name="BatchResponse" type="ns2:BatchResponseType"/>
    <xs:complexType name="BatchResponseType">
     <xs:sequence>
         <xs:element name="Create" type="ns2:CreateResponseType"/>
      <xs:element name="Update" type="ns2:UpdateResponseType"/>
      <xs:element name="Get" type="ns2:GetResponseType"/>
     </xs:sequence>
</xs:complexType>
 
<xs:complexType name="CreateResponseType">
    <xs:sequence>
<xs:element maxOccurs="unbounded" minOccurs="0"
                        type="ns7:Account" name="Account"/>
      <xs:element name="RequestErrorFault" maxOccurs="1"
                 minOccurs="0" 
                   type="ns9:RequestErrorFaultType"/>
      <xs:element name="UnexpectedErrorFault" 
                maxOccurs="1" minOccurs="0" 
                type="ns9:UnexpectedErrorFaultType"/>
      <xs:element name="ServerErrorFault"
                 maxOccurs="1" minOccurs="0" 
                 type="ns9:ServerErrorFaultType"/>
    </xs:sequence>
</xs:complexType>

Chaining
Chaining is an Oracle RightNow adapter feature that you can use to correlate multiple
operations within a single batch request. Specifically, you use chaining together with batching
to execute related operations. For operations to be chained together, the source and target
operations of a chain must be in the same unit of work.

Note:

When configuring the Oracle RightNow Cloud Adapter in the outbound direction, do
not select the Commit After processing option if you are using chaining. For
information about configuring the outbound direction, see Oracle RightNow Adapter
User Interface Support for Batching.

For example, the following request has three operations which are all part of the same
sample batch request.

1. Create a Contact.

2. Create an Incident (the primary Contact for this Incident is the one you created in the
first step).

3. Get the Incident (you must return the Incident just created).

Using the attributes highlighted in the example in Example 3-4, provide a look at how this is
accomplished in code.
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Example 3-4    XML for Chaining

  <Batch
xmlns="http://xmlns.oracle.com/pcbpel/adapter/
             rightnow/RNDemo01/RNBatchDemo01/rightnowReference"
xmlns:rna_v1_2="urn:metadata.ws.rightnow.com/v1_2" xmlns:wsdl="http://
schemas.xmlsoap.org/wsdl/"
    xmlns:rnm_v1_2="urn:messages.ws.rightnow.com/v1_2" 
    xmlns:rnn_v1_2="urn:nullfields.ws.rightnow.com/v1_2"
    xmlns:rnf_v1_2="urn:faults.ws.rightnow.com/v1_2" 
xmlns:ns1="urn:base.ws.rightnow.com/v1_2"
    xmlns:rno_v1_2="urn:objects.ws.rightnow.com/v1_2" xmlns:plnk="http://
docs.oasis-open.org/wsbpel/2.0/plnktype"
    xmlns:http="http://schemas.xmlsoap.org/wsdl/http/" xmlns:soap="http://
schemas.xmlsoap.org/wsdl/soap/"
    xmlns:rng_v1_2="urn:generic.ws.rightnow.com/v1_2"
         xmlns:rnw_v1_2="urn:wsdl.ws.rightnow.com/v1_2"
   xmlns:tns="http://xmlns.oracle.com/pcbpel/adapter/
        rightnow/RNDemo01/RNBatchDemo01/rightnowReference"
    xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
    <tns:CreateContact>
        <tns:Contact>
            <ns1:ID xsi:type="ns1:ChainSourceID"
                         variableName="MyContact" />
            <rno_v1_2:Name>
                <rno_v1_2:First>John</rno_v1_2:First>
                <rno_v1_2:Last>Doe</rno_v1_2:Last>
            </rno_v1_2:Name>
        </tns:Contact>
    </tns:CreateContact>
    <tns:CreateIncident>
        <tns:Incident>
            <ns1:ID xsi:type="ns1:ChainSourceID"
            variableName="MyIncident" />
            <rno_v1_2:PrimaryContact>
                <rno_v1_2:Contact>
                    <ns1:ID xsi:type="ns1:ChainDestinationID" 
variableName="MyContact" />
                </rno_v1_2:Contact>
            </rno_v1_2:PrimaryContact>
            <rno_v1_2:Subject>This is a test subject.
                         </rno_v1_2:Subject>
        </tns:Incident>
    </tns:CreateIncident>
    <tns:GetIncident>
        <tns:Incident>
            <ns1:ID xsi:type="ns1:ChainDestinationID" 
                      variableName="MyIncident" />
        </tns:Incident>
    </tns:GetIncident>
</Batch>

There are request and response payloads associated with Example 3-5 provides an
example of an integration request payload.

Example 3-5    Integration Request Payload

<Batch
   xmlns="http://xmlns.oracle.com/pcbpel/adapter/
     rightnow/RNDemo01/RNBatchDemo01/rightnowReference"
    xmlns:rna_v1_2="urn:metadata.ws.rightnow.com/v1_2" xmlns:wsdl="http://
schemas.xmlsoap.org/wsdl/"
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    xmlns:rnm_v1_2="urn:messages.ws.rightnow.com/v1_2" 
             xmlns:rnn_v1_2="urn:nullfields.ws.rightnow.com/v1_2"
    xmlns:rnf_v1_2="urn:faults.ws.rightnow.com/v1_2" 
xmlns:ns1="urn:base.ws.rightnow.com/v1_2"
    xmlns:rno_v1_2="urn:objects.ws.rightnow.com/v1_2" xmlns:plnk="http://docs.oasis-
open.org/wsbpel/2.0/plnktype"
    xmlns:http="http://schemas.xmlsoap.org/wsdl/http/" xmlns:soap="http://
schemas.xmlsoap.org/wsdl/soap/"
    xmlns:rng_v1_2="urn:generic.ws.rightnow.com/v1_2" 
xmlns:rnw_v1_2="urn:wsdl.ws.rightnow.com/v1_2"
    xmlns:tns="http://xmlns.oracle.com/pcbpel/
        adapter/rightnow/RNDemo01/RNBatchDemo01/rightnowReference"
    xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
    <tns:CreateContact>
        <tns:Contact>
            <ns1:ID xsi:type="ns1:ChainSourceID" variableName="MyContact" />
            <rno_v1_2:Name>
                <rno_v1_2:First>John</rno_v1_2:First>
                <rno_v1_2:Last>Doe</rno_v1_2:Last>
            </rno_v1_2:Name>
        </tns:Contact>
    </tns:CreateContact>
    <tns:CreateIncident>
        <tns:Incident>
            <ns1:ID xsi:type="ns1:ChainSourceID" 
                               variableName="MyIncident" />
            <rno_v1_2:PrimaryContact>
                <rno_v1_2:Contact>
                    <ns1:ID xsi:type="ns1:ChainDestinationID" 
variableName="MyContact" />
                </rno_v1_2:Contact>
            </rno_v1_2:PrimaryContact>
            <rno_v1_2:Subject>This is a test 
                              subject.</rno_v1_2:Subject>
        </tns:Incident>
    </tns:CreateIncident>
    <tns:GetIncident>
        <tns:Incident>
            <ns1:ID xsi:type="ns1:ChainDestinationID"                           
          variableName="MyIncident" />
        </tns:Incident>
    </tns:GetIncident>
</Batch>

The response payload is shown in Example 3-6:

Example 3-6    Integration Response Payload

<itns:BatchResponse xmlns:n0=
                  "urn:messages.ws.rightnow.com/v1_2"
    xmlns:n2="urn:base.ws.rightnow.com/v1_2" xmlns:xsi="http://www.w3.org/2001/
XMLSchema-instance"
    xmlns:n1="urn:objects.ws.rightnow.com/v1_2" 
xmlns:itns="urn:oracle.cloud.adapter.rightnow/1214">
    <itns:Create>
 
        <itns:Contact>
            <n2:ID id="1903" />
        </itns:Contact>
    </itns:Create>
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    <itns:Create>
 
        <itns:Incident>
            <n2:ID id="455" />
        </itns:Incident>
    </itns:Create>
    <itns:Get>
 
        <itns:Incident>
            <n2:ID id="455" />
            <n2:LookupName>140623-000003</n2:LookupName>
            <n2:CreatedTime>2014-06-23T14:44:03.000Z</n2:CreatedTime>
            <n2:UpdatedTime>2014-06-23T14:44:03.000Z</n2:UpdatedTime>
            <n1:CreatedByAccount>
                <n2:ID id="2" />
            </n1:CreatedByAccount>
            <n1:InitialResponseDueTime>2014-06-24T00:00:00.000Z
            </n1:InitialResponseDueTime>
            <n1:Interface>
                <n2:ID id="1" />
            </n1:Interface>
            <n1:Language>
                <n2:ID id="1" />
            </n1:Language>
            <n1:PrimaryContact>
                <n1:Contact>
                    <n2:ID id="1903" />
                </n1:Contact>
            </n1:PrimaryContact>
            <n1:Queue>
                <n2:ID id="2" />
            </n1:Queue>
            <n1:ReferenceNumber>140623-000003</n1:ReferenceNumber>
            <n1:Source>
                <n2:ID id="6006" />
                <n2:Parents xsi:type="n2:NamedReadOnlyID">
                    <n2:ID id="32007" />
                </n2:Parents>
            </n1:Source>
            <n1:StatusWithType>
                <n1:Status>
                    <n2:ID id="1" />
                </n1:Status>
                <n1:StatusType>
                    <n2:ID id="1" />
                </n1:StatusType>
            </n1:StatusWithType>
            <n1:Subject>This is a test subject.</n1:Subject>
        </itns:Incident>
    </itns:Get>
</itns:BatchResponse>

Using Chaining
Chaining is always used together with batching and does not require any extra step in
the Oracle RightNow adapter batch configuration wizard.

However, to use chaining, you must link the right chain source and destination in the
adapter request, as illustrated in the sample request above.
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The following steps illustrate how you can achieve chaining during transformation with the
Oracle XSLT mapper.

1. In the Oracle XSLT Mapper, load the Oracle RightNow adapter reference/business
service request type as the target type.

2. When creating a contact object which must be chained to a different object example,
Incident), substitute the Contact ID with the extension ChainSourceID.

Figure 3-6    Choosing a Substitute Element or Type in the XSLT Mapper

3. Expand the Contact object.

4. Right-click the ID element and select Substitute Element or Type from the popup.

5. This opens the Substitute Element or Type dialog. In the dialog, select ChainSourceID.
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Figure 3-7    Substitute Element or Type Dialog

This substitution extends the Contact ID type.

Figure 3-8    Contact ID Type Expanded

Set the variableName property with a unique string (for example: MyContact) that
uniquely identifies this chain head.

6. During the Create Incident operation, set the following: in the PrimaryContact
field of Incident, set the ChainDestinationID so the Incident is created for the
Contact as they are Chained.

In other words, ChainDestinationID of MyContact is set on the PrimaryContact
field.

<rno_v1_2:PrimaryContact>
                    <rno_v1_2:Contact>
                   <ns1:ID xsi:type="ns1:ChainDestinationID" 
           variableName="{string ('MyContact' )}"/>
             </rno_v1_2:Contact>
</rno_v1_2:PrimaryContact>

7. Similarly, to create Incident and subsequently perform a Get on this incident,
substitute the Incident ID with the chainSourceID. Set the variableName
property with a unique string (example: MyIncident).
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8. Next, in the Get operation, substitute the Incident ID with the extension
ChainDestinationID and set the variableName property to the variable name of the
chainSourceID (that is, MyIncident).

9. Map other types as appropriate.

Supported Processing Options
Use processing options to enable and disable certain aspects of server-side processing when
performing a RightNow cloud operation. Processing options are created and supplied to the
various WSDL operations that use processing options. Following is a list of all supported
processing options, along with their usage and default values. This section includes the
following subsections:

• CreateProcessingOptions

• Using the Batching Feature

• Chaining

• Using Chaining

CreateProcessingOptions
You can use CreateProcessingOptions together with the Create operation, by specifying
them on the Create Properties Tab. CreateProcessingOptions contain properties listed in 
Table 3-1.

Table 3-1    CreateProcessing Options

Field Description

SuppressExternalEvents Used to indicate that external events should not run after the Create
operation completes. The default value is language specific, refer to
your documentation and generated client code for more information
on the default value.

SuppressResponse RightNow adapter-specific option. This property, which takes boolean
values, indicates if an ID must be returned for a Create operation.

SuppressRules Used to indicate that business rules should not run after the Create
operation completes. Refer to your documentation and generated
client code for more information on the default value

DestroyProcessingOptions
You can use DestroyProcessiongOptions together with the Delete operation, by specifying
them on the Delete Operation Properties tab. DestroyProcessingOptions contain the
following properties.

Table 3-2    Destroy Processing Options

Field Description

SuppressExternalEvents Used to indicate that external events should not run after the Destroy
operation completes. Refer to your documentation and generated
client code for more information on the default value.
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Table 3-2    (Cont.) Destroy Processing Options

Field Description

SuppressRules Used to indicate that business rules should not run after the Destroy
operation completes. Refer to your documentation and generated
client code for more information on the default value

GetProcessingOptions
You can use GetProcessiongOptions together with the Get operation by specifying
them on the Get Operation Properties Tab. GetProcessingOptions contain the
following properties.

Table 3-3    GetProcessing Options

Field Description

FetchAllNames Signals to the server that all NamedID types should include both
the Name and the ID for that field. Note the use of this if very
inefficient and should only be used when all Name and ID fields
are required. If all Name and ID fields are not require, this option
should not be used, for more information, see the Get operation

UpdateProcessingOptions
You can use UpdateProcessingOptions together with the Update operation by
specifying them on the Update Operation Properties Tab.
UpdateProcessingOptions contain the following properties:

Table 3-4    UpdateProcessingOptions

Field Description

SuppressExternalEvents Used to indicate that external events should not run after the
Update operation completes. The default value is language
specific, refer to your language documentation and generated
client code for more information on the default value.

SuppressRules Used to indicate that business rules should not run after the
Update operation completes. The default value is language
specific, refer to your language documentation and generated
client code for more information on the default value.

Working with ROQL
The RightNow Object Query Language (ROQL) facility enables you to make queries
against the RightNow Cx database.

This section includes the following information:

• Using ROQL

• ROQL Query Statement
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• Running the ROQL Query Statement

• Using the ROQL Query Builder

• Adapter Support for ROQL

Using ROQL
If you select the ROQL operation category on the Operations screen, a field for entering an
ROQL query is displayed. Enter the ROQL statement depending on the operation you
selected.

ROQL enables you to search your organization's RightNow Cx data for specific information.

This chapter does not focus on discussing ROQL at length. Refer to Oracle Service Cloud
Connect Web Services for SOAP.

ROQL Query Statement
The ROQL query statement queries data from Oracle RightNow Cx. The Query statement
text box consists of ROQL statements according to Oracle RightNow CX.

Refer to the section on ROQL Operations for more information on the query operation. For
detailed information on ROQL, see the Oracle RightNow Connect Web Services for SOAP
Developer's Guide and navigate to the ROQL section.

ROQL Query Statement
Use the ROQL query statement to query data from RightNow Cx. The Query statement text
box consists of ROQL statements according to RightNow Cx.

Refer to the section in ROQL Operations for additional information on query operations. For
detailed information on ROQL, see the Oracle RightNow Connect Web Services for SOAP
Developer's Guide and navigate to the ROQL section.

Running the ROQL Query Statement
You can run and test the query. When you click the Test icon, a test dialogue box appears.

The Query Test dialog that appears contains the following areas:

• Query Statement and Results. The Query Statement text box is for the query itself and
the Results box shows the result of the query executed. If the query has one or more
bind parameters in it, one or more input boxes will appear to provide values for these

• Parameter Bindings. Enter values for any parameter bindings that appear in the query
statement.

• Test My Query. Click to execute the query.

• Results. After the successful execution of the query, the text area is filled with results
from RightNow Cx.

Using the ROQL Query Builder
This section discusses how to use the ROQL query builder. The ROQL query builder
addresses several areas that are often problematic for the integration developer.
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This approach helps you in writing complex, error-free queries with greater ease. To
accomplish writing such queries, the ROQL Query Builder provides the following
features, described in these subsections:

• Simplifying the Discovery of Standard and Custom Business Objects

• Suggesting Query Constructs Based on the Context

• Providing Auto-Completion

• Providing Alias Support to Improve Readability

• Using ROQL to Suggest Relationships

• Using the Query Builder to Obtain Inline and Semantic Validation

Simplifying the Discovery of Standard and Custom Business Objects
The ROQL Query Builder identifies for you potential standard and custom objects that
you can use in constructing the queries. To see an example of this feature:

1. Select ROQL as the operation type on the Operations screen.

2. Enter Select in the ROQL Editor Text area and enter Ctrl+Space. The Query
Builder displays a list of standard and custom objects available on Oracle
RightNow Cx.

Note:

If the custom objects you create do not appear in the list of objects
shown in the operations page, check the option Clear Cache in the
connection page, then connect again to obtain the latest metadata from
the RightNow Cx system.

3. Alternatively, you can provide a specific package to display all custom objects
created in that package.

Suggesting Query Constructs Based on the Context
ROQL Query Builder automatically identifies the context, based on the position of the
cursor, for the query string. Using this context, the Query Builder provides
recommendations, enabling you to write efficient ROQL queries. This feature operates
in the following manner:

1. When you enter Select in the ROQL query text area and press Ctrl+Space, the
Query Builder displays all standard and business objects.

2. Similarly, if you perform the query Select Contact from Contact where and
enter Ctrl+Space after the where clause, you are provided with the list of fields of
the Contact object that you can use in fine-tuning the query, and applicable
keywords and functions.

Providing Auto-Completion
The auto-completion feature facilitates building complex ROQL queries in a quick and
efficient manner. To see this feature:

Chapter 3
Working with ROQL

3-22



• Using the query string Select Se, if you perform Ctrl+Space after the term, Se, the
Query Builder displays all objects that start with Se.

Providing Alias Support to Improve Readability
The ROQL Query Builder features support for aliasing. It recognizes when aliasing of the
RightNow Object (Base class for all primary objects in the Oracle RightNow adapter) is being
queried and treats the alias name as the actual object name.

All operations associated with the object can then be performed on the alias.

1. In the query string Select from ServiceCategory S where, S is set as an alias for
object ServiceCategory. Thus, you can perform all operations associated with
ServiceCategory on the alias 'S'. Some of the operations you can perform on the alias
include the following.

2. If you perform Ctrl+Space between Select and from in the query above, the query
builder will display S, suggesting that the S should come in between Select and From, as
shown here - Select S from ServiceCategory S where.

3. If you enter a dot after the first S, all relationships associated with Service Category are
displayed.

4. Similarly in this query, Select S from ServiceCategory S where S, if you enter a dot
after the last S, all fields associated with ServiceCategory will be displayed.

Using ROQL to Suggest Relationships
ROQL has support for the relationship feature. With this feature you can reach from one
primary object to other primary objects through a relationship.

The ROQL Query Builder identifies and lists all reachable relationships from the identified
object. It can list relationships of relationships.

For more details see Oracle RightNow Connect Web Services for SOAP Developer's Guide

If you must find the parent organization of a particular Contact, enter Select Contact in the
ROQL text area and enter "." which displays all relationships possible on the Contact object.

Using the Query Builder to Obtain Inline and Semantic Validation
The Query Builder has a built-in inline validator that highlights problematic text by drawing a
red curved line underneath it and also provides suggestions to correct the error in a tooltip
message.

The Query Builder validator performs spelling checks on keywords, object names,
relationship names, field names and names of functions. All the keywords that are typed
correctly will automatically be colored blue, indicating the validity of these keywords.

The ROQL Query builder also has support for semantic validation of the query. It can
recognize that the specified relationship or field name is invalid for the currently selected
object.

Adapter Support for ROQL
The Oracle RightNow adapter provides a query subsystem that enables you to perform SQL-
like queries against the RightNow CX platform using the object query language.
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The ROQL query language is based on a subset of the Object Query Language (OQL)
and a SQL-like query language that has been extended to handle object notation.

ROQL currently supports only the Query Objects Feature and not Query CS.

Query Arguments
Using the following query as an example:

Use query arguments to fine-tune queries. Therefore, in the above example, Lin and
CA are query arguments.

Select Contact from Contact where Contact.Name.First = 'Lin' AND 
Contact.Address.City = 'CA'

Query parameters are a unique concept through you can parameterize the query
arguments, which the adapter substitutes with actual values during query execution.

Much like SQL, the query language has a provision to fine-tune the search by passing
in filters in the WHERE clause. This fine-tuning is made possible by use of the concept of
bind parameters.

Support for Bind Parameters
The Oracle RightNow adapter provides you an option to give inputs to your query
statement in the form of bind parameters.

See the following query example for the Oracle RightNow adapter. The ampersand &
symbol prefixed to orgid indicates that the ampersand is a bind parameter.

You can run the query to see how it works with bind parameters by clicking Test My
Query.

As shown above, the query prompts you to provide a value for the bind parameter.

The WSDL generated for an adapter query contains the bind parameter as part of
input schema.

Figure 3-9    Part of Generated Input Schema for WSDL Showing Bind Parameter

The JCA file generated for an adapter query can look as follows:

Example 3-7    JCA File Generated when Bind Parameters are Used in Query

<adapter-config name="rightnowReferencePortType" adapter="rightnow" 
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wsdlLocation="../WSDLs/rightnowReference.wsdl" xmlns="http://
platform.integration.oracle/blocks
          /adapter/fw/metadata">
                 <connection-factory location=
                         "cloud/CloudAdapter">
    <non-managed-connection managedConnectionFactoryClassName="oracle.cloud.connector.
                            rightnow.
              RightNowConnectionFactory">
      <property name="targetWSDLURL" 
                           value="../WSDLs/soap.wsdl"/>
      <property name="csfkey" value="csf21"/>
      <property name="appID" 
                  value=
                "removeWhenAppIdIsHardcodedByRNPlugin"/>
      <property name="applicationVersion" value="1_2"/>
    </non-managed-connection>
  </connection-factory>
  <endpoint-interaction
                      portType="rightnowReferencePortType" 
                             operation="Get">
    <interaction-spec className="oracle.tip.adapter.cloud.
                          CloudInteractionSpec">
      <property name="targetOperation" value="Get"/>
      <property name="operationPath" value="Get"/>
      <property name="gpo.fetchAllNames" value="false"/>
    </interaction-spec>
  </endpoint-interaction>
</adapter-config>

Once queries are parameterized, the Oracle RightNow adapter enables its consumers to
pass in the query parameters as part of the request payload.

The adapter dynamically substitutes the query parameter from the request payload to
reconstruct the ROQL query with arguments during service invocation.

Thus, by using the adapter to easily define query parameters, you can parameterize query
arguments and dynamically inject these parameters at runtime.
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4
Understanding Oracle RightNow Adapter
Advanced Concepts

This chapter describes the design-time and runtime advanced capabilities of the Oracle
RightNow adapter.
This chapter contains information on the following features:

• Understanding the SOAP API

• Handling the Polymorphic Behavior of Oracle RightNow Cx Schema

• Integrating with Custom Objects in the Cloud

• Understanding Oracle RightNow Adapter Security Management

• Oracle RightNow Adapter Test Functionality

• Oracle RightNow Adapter Limit and Restriction Handling

Understanding the SOAP API
The Oracle RightNow adapter requires a connection to enable you to perform operations on
business objects. In addition to operations on business objects, the RightNow API model also
includes a definition of the types of transactions used when the Oracle RightNow adapter
communicates with RightNow Cx.

Understanding Objects
There are two types of objects upon which the Oracle RightNow adapter enables you to
perform actions:

• Standard business objects. These are objects delivered by the Oracle RightNow SaaS
application. Primary objects are objects with a unique ID (primary key) which can be
directly created, read, updated, and deleted. All primary objects inherit from the RightNow
RNObject. Primary objects have no set lifecycle in the Oracle RightNow Cx platform,
meaning that once the objects are created, they exist in the system until they are deleted.
While primary objects have their own life cycle, sub objects that could be anywhere
between 0 to many for a single primary object, live within the context of primary objects.
Hence, their life cycle is based on the life cycle of the primary object. The exact lifecycle
behavior for objects can be obtained from the relationship information contained in the
metadata or in the object model documentation.

• Custom business objects. A custom business object is an object that has been created
by a customer. It can be modeled after any standard object, or it can be entirely unique.
When created, custom objects are treated and act just like standard, primary objects. The
only difference between the standard objects and custom objects is in the name of the
object that is used. For the primary objects, you can use the name of the class such as
'Contact'. For custom objects, you can use the combination of the package name and
custom object name to uniquely identify the custom object. The package name and
object name are joined by a '.'. For example, if there was a custom object package called
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'CO' and a custom object named PurchasedProduct you would reference this
object as CO$PurchasedProduct.

Understanding Transactions
The RightNow adapter supports the message exchange patterns supported by
RightNow SaaS application. It is a synchronous request - response based message
exchange pattern. The BPEL / OSB application makes a synchronous request to
RightNow adapter and waits for a response. The adapter in turn does the necessary
transformation on the same thread before making a synchronous request to RightNow
Cx Server using the RightNow SOAP API.

The response returned by RightNow application after necessary processing is in turn
received by the calling thread. The adapter performs the transformation before
sending the response back to BPEL / OSB based client application.

Every operation that writes to RightNow Cx object, such as create or update is, by
default, committed. Batch Operation does enable the integration developer to override
the default. For more information about batching support, see Using the Batching
Feature.

Handling the Polymorphic Behavior of Oracle RightNow Cx
Schema

Oracle Cloud Connect Web Services for SOAP defines a number of operations which
either accept or return one or more instances of RNObject (which is the Base class for
all primary RightNow object classes).

This feature enables the same operations to behave in a polymorphic manner, in
which the input and return values can be any instance of a derived class of RNObject.

This feature accomplishes this behavior by passing in subclass instances from
program language bindings, and also through the use of the xsi:type attribute in the
serialized XML for the object. The xsi:type specifies the concrete type that is being
substituted in the element with the type RNObject. This behavior enables developers
working with Oracle Cloud Connect Web Services for SOAP to work with any type of
object that inherits from the base class, RNObject and to pass this object into any
operation that expects an instance of RNObject. In addition, developers can cast
returned instances of RNObject to the appropriate subclass. For more information on
polymorphic behavior, see Oracle Service Cloud Connect Web Services for SOAP.

Due to this polymorphic nature, mapping from source object to target object user
experience is somewhat complex for standard objects that inherit RNObject. For
custom objects and custom attributes, it is more complex.

The Oracle RightNow adapter elevates the element definitions as first-class citizens
for standard objects, custom objects and custom fields, reducing the number of steps
you must perform to create complex transformations and simplifying your experience
mapping source to target definitions.

Example: Mapping A Custom Object
Following is a sample of a mapping experience of a custom object with and without
Oracle RightNow adapter. The example might not be typical, but it helps you
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understand the mapping experience and the differences between doing so with and without
the Oracle RightNow adapter.

One example shows mapping an Oracle RightNow custom object without using an Oracle
RightNow adapter. The second example shows the same mapping, the difference being that
the second example is greatly simplified; the adapter simplifies the process.

Example: Mapping an Object without Using an Oracle RightNow Adapter
This section provides information about creating a custom object instance without using the
Oracle RightNow adapter. In this scenario, you create a SOA Composite and use the Web
Service adapter to create a client for RightNow Service. The steps follow that are required
when you create a data mapping using XSLT mapper from a client source schema to a
custom object schema.

See Figure 4-1.

1. In the XSLT editor, on the target schema node RNObject, right-click and select
Substitution Type or Element then choose Generic Object.

2. Set Object ObjectType->TypeName: Value of the RightNow CustomObject Name created
in RightNow.

3. Set GenericFields->dataType: Data type value of the custom attribute. for example,
STRING, or INTEGER.

4. Set GenericFields->name: name of the custom attribute.

5. Set GenericFields->DataValue->StringValue: Value of the attribute.

Figure 4-1    Using XSLT Mapper to Map a RightNow Custom Object for the Schema
without Using the Oracle RightNow Adapter-Generated WSDL

The source view is:
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Figure 4-2    Sample XSL File in Source Mode

Example: Mapping an Object with the Oracle RightNow Adapter
This section provides information about creating a custom object instance with the
Oracle RightNow adapter. You create a SOA Composite and use the Web Service
adapter to create a client for an integration-friendly Oracle RightNow adapter-
generated WSDL.

Use the following steps to create the data mapping using the XSLT mapper from a
client source schema to a custom object schema (the schema is strongly typed and
referred from the integration-friendly WSDL generated by the Oracle RightNow
adapter). The custom object is a first class entity in generated Local WSDL Map the
fields directly in the mapper as shown below.
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Integrating with Custom Objects in the Cloud
A custom object is an object that has been created by a customer. It can be modeled after
any standard object, or it can be entirely unique. It can either be a standalone object or it can
be the child of an existing standard object.

Creating Custom Objects in the RightNow Cx Server
Follow these instructions to create custom objects in the RightNow Cx server.

1. Log in to the Oracle RightNow Cx client, and follow instructions in Configuring Restricted
Access Permissions on RightNow Cx.

2. Click Configuration on the navigation pane.

3. Double-click Object Designer under Database. The object designer opens on the
content pane.

4. Select a package to which you want to add the custom object, or create a new package
for the object by clicking New on the ribbon and selecting Package. Enter the name you
want for the package. Package names must be between two and eleven characters in
length.

5. Click New on the ribbon and select Object. The Object Summary page displays.

Figure 4-3    Object Summary Page

6. Enter a name for the object in the Name field.

7. Click Fields on the ribbon to add predefined or customized fields to the object and add
custom fields. For additional information, see the Oracle RightNow Connect Web
Services for SOAP documentation.
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8. Click the Save and Close button on the ribbon to save changes to the custom
object. RightNow performs a validation when either the Save or Save and Close
buttons are clicked. Any validation errors, such as a missing field name, display in
a message and must be corrected before the object can be saved.

9. Deploy the custom objects when you are ready.

Selecting Custom Objects to Perform Operations
Once a custom object has been created, you can select the object against which to
perform operations on the Operations page.

Once you select the custom object, an Integration-friendly WSDL is generated with
custom object schema in strongly typed format. A non-normative sample of the
generated custom object schema is shown in Figure 4-4.

Figure 4-4    Example of a Custom Object Schema

Understanding Oracle RightNow Adapter Security
Management

The Oracle RightNow adapter uses the Credentials Store Framework to store
credentials captured during the configuration of connections within the Oracle
RightNow adapter configuration wizard. This ensures that the credentials captured
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during configuration are stored in secured form and are not stored with the SOA Composite
or Oracle Service Bus flow.

At runtime, the adapter automatically retrieves the credentials from the Credentials Store
Framework based on the CSF_KEY that was specified during design time. These credentials
are injected into the SOAP header of the document that is sent to the RightNow Cx Server for
authentication.

Authenticating on the Oracle RightNow Cx Server with Account Passwords
The following section provides information about authenticating on the Oracle RightNow Cx
Server with account passwords. This section includes:

• Understanding Access Control on the Oracle RightNow CX Server

• Configuring Restricted Access Permissions on RightNow Cx

Understanding Access Control on the Oracle RightNow CX Server
When the Oracle Cloud Connect Web Services for SOAP API receives a request, a series of
access control measures are enforced:

1. The site configuration is checked to ensure the API has been enabled at a site level.

2. The user credentials supplied in the request are validated.

3. The profile for the supplied account is checked to ensure the correct profile bit is enabled.
The profile is the mechanism for controlling access to administrative functions and for
assigning staff members specific permissions, default workspaces, a default navigation
set, and report access.

Note:

Server-side access control is enforced on all core API calls made by Oracle
Cloud Connect Web Services for SOAP. The current permissions map to read,
edit, delete, and move check boxes on the Profile Permissions editor in Oracle
RightNow. Although server-side access is enabled by default on new May 2013
sites and later, it is disabled on upgraded sites before the May 2013 release. If
you are an existing Oracle RightNow customer and plan to upgrade your site to
a May 2013 or later build, contact customer care to have this security-
enhancing functionality enabled.

If you already have server-side access control enabled on your site, be careful
of changes you make to Profile permissions. If an Oracle RightNow
administrator changes the permissions on a profile for an Oracle Cloud Connect
Web Services for SOAP integration, they might break that integration.

Oracle Cloud Connect Web Services for SOAP Site Configuration
Access to the Oracle Cloud Connect Web Services for SOAP is available only on those sites
that have it enabled. If Oracle Cloud Connect Web Services for SOAP is not enabled, contact
your Oracle account manager, as the API will not function and a request error will be
returned.

Chapter 4
Understanding Oracle RightNow Adapter Security Management

4-7



Request errors are generated any time there is a validation failure or a data related
error of the inbound request. The exception code will be ACCESS_DENIED and the
message will be the message base string for SOAP_SERVER_DISABLED.

For complete information on request errors and exception codes, see Oracle Connect
Web Services for SOAP.

Before staff accounts can be authenticated through Oracle RightNow Cx, their
profile(s) must be updated on the Profile Permissions editor in Oracle RightNow Cx.
The permissions check boxes are located at Staff Management > Profiles >
Permissions.

Figure 4-5    Location of Permissions Checkboxes

In addition, RightNow Cx administrators can restrict access to Oracle Cloud Connect
Web Services for SOAP integrations by IP address using the configuration settings in
the Oracle RightNow Cx platform. The following setting is located at Site
Configuration > Configuration Setting.

• SEC_PAPI_INTEG_HOSTS_SOAP: Defines which hosts are allowed to access the
SOAP interface. Valid entries include a comma-separated list of domain names
with wild cards, specific IP addresses, or IP subnet masks (for example,
*.rightnow.com,1.2.3.4, 10.11.12.0/255.255.255.0).

Only users logging in from hosts matching entries in this list are allowed access to
the SOAP interface. The default is blank.

Configuring Restricted Access Permissions on RightNow Cx
To configure restricted access permissions:
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1. Install the Oracle RightNow Cx client.

2. Log in to the Oracle RightNow Cx client installed on your workstation. You can
immediately begin configuring and customizing the application.

To access the same site in the future, you can launch the client by selecting Start menu
> All Programs > RightNow > RightNow (<site_name>). The client application is site-
based, meaning that a separate client must be deployed for each site you access.

However, a single client application can be used to access all interfaces on a single site.
Interfaces are added to the client in the same way the client is deployed.

Access the interface's Launch page and click the Install Oracle RightNow CX Cloud
Service button (as described in the Oracle RightNow Cx User's Guide), and the
deployment tool adds the interface to the Interface drop-down menu on the client's Login
window.

3. Configure the SEC_PAPI_INTEG_HOSTS_SOAP setting. Refer to the Oracle RightNow Cx
User's Guide.

Validating Account Credentials
When a request is sent to the API and the site configuration has been validated, the next step
is to validate the account credentials. If the credentials do not verify, a request error is
returned. The exception code will be INVALID_LOGIN, and the message will be the message
base string LOGIN_ID_PASSWD_COMBINATION_INV_MSG.

Profile Configuration
The profile for the staff account which is used in the security header must have the Public
SOAP API profile bit enabled. If this bit is not enabled, a request error is returned. The
exception code will be ACCESS_DENIED, and the message will be the message base string
PROFILE_NO_SOAP_ACCESS_MSG.

Password-based Authentication
Oracle Cloud Connect Web Service for SOAP utilizes Web Services Policy 1.2 is defined by 
http://specs.xmlsoap.org/ws/2004/09/policy/ws-policy.pdf for client authentication.

The supporting XSD for the security policy is located at http://schemas.xmlsoap.org/ws/
2004/09/policy/ws-policy.xsd.

To authenticate with single sign-on, refer to Authenticating with SAML 2.0.

The WS-Security specification calls for a Security tag in the SOAP Header with a namespace
of

http://docs.oasis-open.org/wss/2004/01/oasis-200401-wss-wssecurity-secext-1.0.xsd.

Inside the Security tag is a UsernameToken tag (part of the WS-Security UsernameToken
Profile 1.0 specification). The UsernameToken tag contains elements for Username, Password,
Nonce, and Created. The Password element has a Type attribute which specifies if the content
of the Password element is PasswordText. Oracle Cloud Connect Web Services for SOAP
does not support PasswordDigest.
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The Nonce and Created elements are not supported. If a request is received that
contains the PasswordDigest type or the Created/Nonce elements, the server rejects
the request as a malformed request.

The following is an example SOAP request with username and password credentials:

Example 4-1    Example SOAP Request with Username and Password Credentials

 soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/">
    <soapenv:Header>
        <wsse:Security xmlns:wsse="http://docs.oasis-open.org/wss/2004
             /01/oasis-200401-wss-wssecurity-secext-1.0.xsd"
                   soapenv:mustUnderstand="1">
            <wsse:UsernameToken
                xmlns:wsu="http://docs.oasis-open.org/wss/2004/01/
                  oasis-200401-wss-wssecurity-utility-1.0.xsd" 
                      wsu:Id="UsernameToken-3902281">
                <wsse:Username>comland</wsse:Username>
                <wsse:Password Type=
                     "http://docs.oasis-open.org/wss/2004
                      /01/oasis-200401-wss-username-token-profile-1.0
                       #PasswordText">Connect1</wsse:Password>
            </wsse:UsernameToken>
        </wsse:Security>
    </soapenv:Header>
</soapenv:Envelope>

Oracle RightNow Adapter Test Functionality
Test functionality is a distinctive feature of the Oracle RightNow adapter that is
available in two forms.

One form enables you to test the connection parameters. The second form enables
you to validate and execute a ROQL query.

The section below provides more information about these two features.

Design-Time Test Functionality Details
Design-time test functionality includes the following test features:

Note:

Ensure that you set up proxy settings in Oracle JDeveloper to connect to the
external SaaS application URL. Otherwise, time out errors can occur.

• Test Right Now CX Cloud Connection: There is a Test button on the Connection
page of the Oracle RightNow adapter configuration wizard.

By clicking Test, you receive either of the following messages:

– Success! - For successful connection

– Failure! - For any exception during login

• Query Test Tool: This tool runs and tests your queries. When you select ROQL
on the Operations page of the Oracle RightNow adapter configuration wizard, a
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test dialogue box appears with a Query Statement text box and a Results box for
showing the query result.

Oracle RightNow Adapter Limit and Restriction Handling
The following limits and restrictions apply to this adapter. They include:

• Delete-Cascading Delete Effect

• API Limits Enforced by the RightNow Cx Server

Delete-Cascading Delete Effect
There is a cascading delete effect when using Oracle RightNow adapter for a Destroy Delete
operation.

Primary objects are deleted directly through the Delete operation. To destroy a primary
object, an instance of the object must be instantiated and the ID property set, but no other
fields require population. When a primary object is deleted, this operation may also “cascade"
to related primary objects.

For additional information on cascading delete effects, and a summary of aggregations that
will cause a cascading delete effect, see the Oracle RightNow Connect Web Services for
SOAP Developer Guide.

API Limits Enforced by the RightNow Cx Server
While usage of Oracle Cloud Connect Web Services for SOAP is unlimited, there are
practical limits which are enforced by the RightNow Cx server.

There are two important limits relevant to the use of the Oracle RightNow adapter:

• 100 Batch items per SOAP request. The Batch operation enforces a hard limit of 100
items. If this limit is exceeded, a fault is returned before completing any operations. If the
limit is exceeded, batch items are not processed.

• Each individual Create, Get, Update, and Destroy operation is limited to 1000 items.
RightNow Cx server checks the number of items in the request at the beginning and if the
number of items is more than 1000, or if the number of items causes the combined
summation of items to exceed the request maximum, RightNow Cx server throws an
exception and does not process the request.

• 10,000 total input objects per SOAP request. The combination of the multi-object
Create, Get, Update and Destroy operations and the Batch operation is limited to 10,000
total input objects per SOAP request. RightNow Cx keeps a running total of objects which
is managed by Create, Get, Update, and Destroy operations. Each time one of the bulk
operations occurs, the number of items is added to the total number of objects processed
in the request.

The processing of the Batch operations occurs until the limit of 10,000 objects is reached.
Once reached, the operation causing the 10,000 limit will be terminated and a fault
returned. Operations contained within the Batch request that do not contain input objects
will continue to execute.

These three limits (100, 1000, 10000) are treated independently. Some operations affect
both the bulk limits and the total operation limits (for example, Create, Get, Update, and
Destroy).
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For additional information, see the see the Oracle RightNow Connect Web Services for
SOAP Developer Guide.
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5
Understanding BPEL Integration with Service
Components (BPEL/Mediator)

This chapter includes these sections:

• Overview

• Designing a Composite for Service Integration

• Configuring the Oracle RightNow Adapter

• Integrating with BPEL

• Deploying the Composite

• Testing the Composite

Overview
To integrate with Oracle BPEL Process Manager, the organization's enterprise WSDL must
be available to the user. The underlying adapter services are exposed as WSDL files, which
are generated during design time in the configuration wizard of the Oracle RightNow adapter.

Use the generated WSDL files to design the appropriate BPEL processes for outbound
adapter services. A completed BPEL process must be successfully compiled in JDeveloper
and deployed to an SOA Suite server. Upon deployment to a SOA Suite server, each newly-
deployed process is viewable in the Oracle Enterprise Manager Fusion Middleware Control,
where you can run, monitor, administer BPEL processes, and monitor adapter events.

Understanding the Account Object
You create an Account object and integrate the WSDL with the Oracle BPEL Process
Manager. Account is one of the standard objects provided by RightNow, an account
generated for a staff member in the RightNow Cx system. Customer service representatives,
sales agents, and site administrators use Accounts.

Specifically, an Account object on RightNow Cx represents an individual or business
associated with the business.

The Oracle RightNow adapter enables you to create an Account object on RightNow Cx.

Designing a Composite for Service Integration
The next steps detail how to design a composite using the Oracle JDeveloper Studio Edition,
a comprehensive tool for developing Oracle Fusion Middleware applications. It provides an
easy-to-use Integrated Development Environment that enables you to create your
integrations efficiently.
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Defining a Composite for BPEL and Mediator
To define a composite for BPEL and Mediator:

1. In the File menu of JDeveloper, click New and select Application.

Figure 5-1    Navigation

JDeveloper displays the New Gallery page. Select SOA Application from the
Items list.
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Figure 5-2    Create SOA Application

2. Provide a suitable name to your application.

Figure 5-3    Name Your Application

Chapter 5
Designing a Composite for Service Integration

5-3



3. Click Next and provide a suitable name to your project.

Figure 5-4    Provide a Name for Your Project

4. Click Next.

5. Select Composite With BPEL Process from the Standard Composite list.
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Figure 5-5    Configure SOA Settings

6. Click Finish.

7. Select the Synchronous BPEL Process from the Template drop-down list and click OK.
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Figure 5-6    Create BPEL Process

The composite.xml file appears.
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Figure 5-7    composite.xml File

8. In the Application Navigator, under the Schemas folder, Oracle JDeveloper displays an
XML schema file with the name BPELProcess1.xsd after BPEL process creation.

Figure 5-8    XML Schema File

9. Edit this schema file as your business needs require. It is the responsibility of the front-
end application to enforce data validations and to ensure that the input sent to the Oracle
RightNow Cx Server from SOA is error-free.
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The structure of the schema used in this use case is as shown below.

Figure 5-9    Edit XML Schema File

Configuring the Oracle RightNow Adapter
To configure a new Oracle RightNow adapter:

Note:

If the Localize Files dialog is displayed during adapter configuration, click
Cancel. You cannot localize the WSDL file.

1. In the External References swimlane of the composite.xml file, right-click and
select Oracle RightNow Adapter.

2. Oracle JDeveloper displays the Basic Info screen.

3. Enter a meaningful name and optional description.

4. Click Next.

5. JDeveloper displays the Connection page. You must provide the WSDL URL/
location, security policy, and authentication key details.
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6. Select the WSDL:

• If you have the WSDL available in the file system, click the Find existing WSDLs
icon, located to the right of the WSDL on the screen. JDeveloper displays the WSDL
Chooser dialog. Browse and select the downloaded Enterprise WSDL and click OK.

7. Click OK.

8. Click OK. You are returned to the Connection page.

9. As an alternative, you can store WSDL at an MDS location and access it. The next
screenshot shows you storing the WSDL at an MDS location.

Figure 5-10    Storing WSDL at an MDS Location
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10. Navigate to IDE Connections-> SOA-MDS. Select the appropriate SOA-MDS
connection where you placed the Enterprise WSDL. Select the WSDL file to be
used in the adapter configuration and click OK.

11. Ensure that the WSDL is of the form:

oramds:/apps/SOA/WSDLs/Integration/rightnowAPI.wsdl

An alternative is to directly provide the https URL:

https://integration-test.rightnowdemo.com/cgi-bin/integration_test.cfg/
services/soap?wsdl

12. Click OK.

13. Click “+" button to create a new Authentication Key.

14. Provide a suitable name and the Right Now credentials and click OK.

15. Click the Test button to validate the Authentication Key.

16. Click Next.

Oracle JDeveloper displays the Operations page.

Figure 5-11    Oracle RightNow Adapter Operations Screen

17. Because the requirement is to create an Account on RightNow, select the CRUD
and Create options from the Select an Operation Type list.

On the same screen, move Account from the list of Available objects to the list of
the Selected objects.

18. Click the Processing Options link in the upper right corner of the screen.

19. Select the processing options for your requirement. Properties displayed in this
page depend on the operation you selected in the previous page. In this case, the
Suppress Response checkbox is selected, and suppressing a response is
disabled, that is, made false. Once this is selected, the Create operation returns a
valid ID for a batch operation instance you are creating.
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20. Click Next. JDeveloper displays the Summary page, which provides a complete summary
of the operation selected, the object on which the operation operates and the headers
selected for that operation.

21. Click Done to complete the Oracle RightNow adapter Configuration wizard.

Figure 5-12    The Services, Components and External References Screen Showing the Adapter in
External References Swimlane

Integrating with BPEL
Perform the following steps to provide integration with BPEL:

1. Connect BPELProcess1 and ServiceCloudCreateAccount using a wire.
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Figure 5-13    BPELProcess1 and RightNowAccount External Reference Connected Through
a Wire

2. After wiring your composite appears.

Figure 5-14    Composite Application with Service, BPELProcess and Reference Wired
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3. Double-click and open BPELProcess1. The Oracle RightNow adapter should be present
as a part of the Partner Links.

Figure 5-15    Oracle RightNow Reference Adapter Shown as Part of Partner Links

4. Add an Invoke activity to invoke the ServiceCloudCreateAccount Partner Link. To add
the Invoke activity:

a. Drag and drop the invoke activity from the BPEL constructs.

Figure 5-16    Invoke Activity
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b. After dropping the Invoke property on the canvas, wire the Invoke activity to
the ServiceCloudAdapter partner link.

5. Create an input variable to the partner link by clicking the + button adjacent to
Input text box in the Variables section. JDeveloper displays the Create Variable
dialog.

Figure 5-17    Create Variable Dialog to Create an Input Variable for the
Partner Link

6. Create an output variable from the partner link by clicking the + button adjacent to
Output text box in the Variables section. The wizard displays the Create Variable
dialog.
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Figure 5-18    Create Variable Dialog to Create an Output Variable

7. Introduce two transform activities, one before the Invoke activity and another after it.
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Figure 5-19    Two Transform Activities in the BPEL Diagram

8. Map Transform1 values from receive activity's input variable to the Invoke
activity's input variable.
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Figure 5-20    Mapping Transform1 Values from Receive Activity's Input Variable to
Invoke Activity's Input Variable

9. Click the + button adjacent to Mapper File text box to open the Transformation_1.xsl
file.

10. Map between inputVariable and Invoke1_create_InputVariable:

• Map Account_Name with Name.

• Map Phone with Phone.

• Map Website with Website.

• Map Description with Description.
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Figure 5-21    Mapping between inputVariable and
Invoke1_create_InputVariable

11. Map Transform2 values from the Invoke activity's output variable to the reply
activity's input variable.
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Figure 5-22    Mapping Transform2 values from Invoke Activity's Output Variable to
Reply Activity's Input Variable

12. Map the output variable.

Figure 5-23    Mappings for Output Variable

This completes the project creation. JDeveloper displays the composite.xml file.
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Deploying the Composite
To deploy the composite application:

1. In the Application Navigator pane, right-click Project1 and select Deploy
Project1.
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Figure 5-24    Deploying the Project

2. Select the Deploy to Application Server option and follow the instructions. Using this
option, you can deploy the composite on the Application server after providing the details
of the server.

Testing the Composite
You can run and test the instances of deployed SOA composite applications from the Oracle
Fusion Middleware Control Console. Doing so enables you to manage a composite
application, initiate and track an instance of a composite and to view detailed component
instance audit trails.

The following process shows you how to test the composite.

Testing the Outbound Process
To test the Outbound process:
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1. Log in to Fusion Middleware Console for the server on which you have deployed
your project.

2. Open Project1 under the Default partition.

3. Click the Test button to test the Web service.

Figure 5-25    Test Button

4. Provide the input payload and click the Test Web Service button.

Figure 5-26    Testing the Web Service

After successful execution, the response contains the id of the account created on
RightNow and Status as success.
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Figure 5-27    Test Response Containing ID of the Account Created on RightNow Cx
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6
Developing Oracle Service Bus Integrations
with the Oracle RightNow Adapter

This section explains how to create Oracle Service Bus projects using the Oracle Service Bus
Console and Oracle JDeveloper. To create these projects, you first need to generate Oracle
RightNow adapter artifacts using Oracle JDeveloper 12c, and subsequently, use those
artifacts while creating Oracle Service Bus projects and services with the Oracle Service Bus
Console.
This chapter contains the following topic:

• Generating Oracle Cloud Adapter Artifacts

Generating Oracle Cloud Adapter Artifacts
To create Oracle Service Bus projects using Oracle Service Bus Console, you must use
Oracle RightNow adapter artifacts generated using Oracle JDeveloper. To create a BPEL
composite, see the section Designing a Composite for Service Integration.

You use the artifacts generated in Configuring the Oracle RightNow Adapter to create Oracle
Service Bus business services in Oracle Service Bus Console.

Creating Oracle Service Bus Projects Using Oracle Service Bus Console
To create Oracle Service Bus projects and services using Oracle Service Bus Console.

1. Log in to Oracle Service Bus Console: http://hostname:port/servicebus.

2. On right side of the page, click Create. This opens a new session in the Oracle Service
Bus console to enable you to make changes.

Figure 6-1    Create an Oracle Service Bus Session

3. Right-click All Projects and click Create - Project.
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Figure 6-2    Adding a New Project to Oracle Service Bus

4. The Oracle Service Bus Console displays the Create a new Project dialog box.

5. Enter the project name in the Resource Name field, and provide the description in
Description field.

Figure 6-3    Create a New Project Page

6. Click Create. A new project named RightNow Create appears under All Projects.

7. Import the Oracle RightNow adapter artifacts in this project. Right-click the Project
name just created. Select Create and select the WSDL.
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Figure 6-4    Choosing WSDL Reference

The console displays the WSDL Creation page.

8. Click Browse and browse to the directory where you have stored the artifacts received
from Oracle JDeveloper. Select the Oracle Cloud Adapter for RightNow WSDL.

Figure 6-5    Creating a WSDL

9. Click Create.

10. Right-click the Project name, from the menu, select Create, and then WSDL.

11. On the WSDL Creation page, browse for rightnowReference WSDL.

Chapter 6
Generating Oracle Cloud Adapter Artifacts

6-3



Figure 6-6    rightnowReference WSDL

12. Click Create.

13. Select JCA Binding from the Create drop-down list under Project Name.

Figure 6-7    Selecting JCA Binding from Create Drop-Down List

The JCA Binding creation dialog box is displayed.

14. Click Browse and browse to the directory where the artifacts received from the
Oracle JDeveloper 12c are stored. Choose the Oracle Cloud Adapter for RightNow
JCA file.
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Figure 6-8    Choosing the RightNow Adapter JCA File

15. Click Create. You are returned to the Project page. You might get an error message
such as The JCA Binding 'rightnowReference_rightnow' was successfully created
with validation errors. View the JCA Binding/Conflicts to see detailed
diagnostic messages.

This error is thrown because the JCA binding cannot find the associated WSDL. To rectify
the error if you receive it, click the JCA file you created and then click Edit.

16. Click Browse. Search for the WSDL you created and click Submit after choosing the
WSDL.

Figure 6-9    Edit JCA Binding References

17. Click Save.

18. Navigate to the project folder. Right-click the JCA Binding just created, and click
Generate WSDL and Service option.

Figure 6-10    Generate WSDL and Service from JCA Binding
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19. Enter a new name for the WSDL name in the New WSDL Name field and the
service name in the New Service Name field.

Note:

Choose the correct location for the new WSDL and service to be
generated.

20. Click Generate.

Figure 6-11    Generate WSDL and Service

The console generates the new WSDL and the new business service.

21. Activate the Oracle Service Bus session by clicking Activate in the right corner.

Figure 6-12    Activate Session

The console displays the Confirm Session Activation dialog box.

22. Click Activate to activate the session.

Figure 6-13    Confirming Session Activation
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23. Click Activate to activate a session.

Creating a Service Bus Project, and Generating the Oracle Service Bus
JCA Business Service

This section describes how to create a Service Bus project using JDeveloper. It also includes
information on generating an Oracle Service Bus JCA Business Service using the Oracle
RightNow adapter. It includes: creating an empty composite for the Oracle Service Bus, then
defining an Oracle Service Bus outbound process, and finally deploying that Oracle Service
Bus project on a server.

Creating an Empty Console for the Oracle Service Bus and Creating a New Service
Bus Project

To create an empty composite for the Oracle Service Bus:

1. Create a new Oracle Service Bus application, Select File >New >Application. The New
Gallery opens, where you can select application components to create.

Figure 6-14    Choosing an Application

2. On the Name your Application page, optionally change the name and directory location
for the application.

Chapter 6
Generating Oracle Cloud Adapter Artifacts

6-7



Figure 6-15    Name Your Application

3. Create a new Oracle Service Bus project.

Figure 6-16    Create a New Project

4. On the Name your Project page, optionally change the name of your Oracle
Service Bus project. Make sure the project directory is in the application directory
(this is the default).
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Figure 6-17    Name Your Project Page

5. Click Finish.

Defining a Service Bus Business Service with the Oracle RightNow Adapter
This section describes how to define an Oracle Service Bus business service for RightNow
integration using the Oracle RightNow adapter, which consists of the following stages:

• Configuring the Oracle RightNow Adapter Component

• Configuring a Proxy Service

• Deploying the Outbound Oracle Service Bus Process

Configuring the Oracle RightNow Adapter Component

To configure an Oracle RightNow adapter component:

Note:

If the Import OSB Resource dialog is displayed during adapter configuration, click
Cancel. You cannot localize the WSDL file.

1. Open the Service Bus Overview Editor.

2. Drag and drop the Oracle RightNow adapter component from the Components panel to
the External Services swim lane.

The Basic Info page of the adapter configuration wizard is displayed.

3. Enter a connection name for the RightNow adapter in the Name field and then click Next.

4. On the Connection page, browse for the Enterprise WSDL location by clicking on the
Browse button.

5. The WSDL Chooser dialog is displayed. Browse and select the downloaded Enterprise
WSDL and click OK.
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6. Click OK.

7. Click Next.

8. Click Finish. The wizard returns you to the Connection page.

9. Select an authentication key from the dropdown, if available, or create an
Authentication key by clicking on + button.

10. Click the Test button to validate the authentication key.

11. Click Next. The Operations page is displayed.

12. The operation by default is Create. You can change this operation by selecting an
operation name suitable to your business requirement.

13. Select the Account business object from the Available list, and move to the
Selected list.

14. Click Next, The Summary page is displayed.

Configuring a Proxy Service

To configure an Oracle Service Bus proxy service:

1. Using the Oracle Service Bus Overview Editor, right-click the Pipeline/Split Joins
lane and click Insert and then Pipeline.

Figure 6-18    Pipeline Component

The Create Pipeline Service dialog is displayed.
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Figure 6-19    Create Pipeline Service Dialog

2. In the Service Name field, enter a name to identify the pipeline name and select the
corresponding location of the project.

3. Click Next and select the Service Type as WSDL.

Figure 6-20    Creating a Pipeline

4. Click the Browse icon, which is located to the right of the WSDL URL, to select the
WSDL from the file system.

5. Select the appropriate WSDL file from the Application -> Resources.
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Figure 6-21    Select WSDL

6. Click OK. The selected WSDL and corresponding binding is displayed. Ensure the
check box for Expose as a Proxy Service is selected.

Figure 6-22    Creating a Pipeline Service

7. Select Proxy Transport as http.

8. Click Finish. The Pipeline component is displayed.
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Figure 6-23    Pipeline Component

9. Connect the Oracle RightNow adapter in the External Services swimlane to the pipeline.

Figure 6-24    Connecting the rightnowReference to the Pipeline Component

10. Open the pipeline which shows the default routing. Verify the service and corresponding
operation will be displayed in the Routing Properties.

Figure 6-25    Routing Properties
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The outbound Service Bus Project is ready to be deployed

Deploying the Outbound Oracle Service Bus Process

To deploy the outbound Oracle Service Bus Project:

1. Select the project and select Deploy to Service Bus Server.

Figure 6-26    Deploy Action

2. Select the already-configured Application Server and click Next.

Figure 6-27    Select Server Page.

3. Check the deployment summary and click Finish.
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Figure 6-28    Summary Page

4. The Success Message page indicates the Project is successfully deployed.

Figure 6-29    Success Message Page

The successfully deployed project can be tested from Service Bus Console.

Testing the Oracle Service Bus Project from the Oracle Service Bus Console
To test the Oracle Service Bus project from the Oracle Service Bus Console:

1. Open the Oracle Service Bus Console and enter the user ID and password.

Figure 6-30    Service Bus Console
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2. All the deployed projects are displayed under All Projects.

Figure 6-31    Service Bus Deployed Projects

3. Open the project you want to test and click Proxy Service of that project. For
example, PipelineProxyService in this case, as shown in the Figure below

Figure 6-32    Proxy Service Definition

4. The Option for Launch Test Console (Green arrow button) is displayed for testing
the outbound endpoint.
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Figure 6-33    Option for Launching Test Console

5. Launching Test Console opens new window displaying the Proxy Service and the
operation to test along with Execute, Execute-Save, Reset and Close button.

Figure 6-34    Proxy Service Testing

The Request Document section contains the Request Payload.

6. Provide the input and click the Execute button. This sends the payload to Oracle
RightNow Cx and the response is displayed under the Response Document section.
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7
Troubleshooting and Error Handling with the
Oracle RightNow Adapter

This chapter explains the troubleshooting information and error messages that you can come
across while configuring the Oracle RightNow adapter.
The chapter contains the following topics:

• Understanding Oracle RightNow Adapter Design-Time JDeveloper Errors

• Understanding API Faults and Error Handling

• Understanding RightNow Exception Codes

• Understanding Adapter Fault Handling

Understanding Oracle RightNow Adapter Design-Time
JDeveloper Errors

The following table shows the common design-time errors faced while using Oracle RightNow
Cx Server in JDeveloper and their possible solutions.

Table 7-1    Oracle Cloud Adapter for RightNow Server CX in JDeveloper

Error Solution

The login credentials are not
valid, or the maximum number
of logins has been exceeded.
Contact your administrator for
more information.

Metadata for the enterprise
WSDL is not available in the
cache.

Provide the valid Oracle Cx credentials. Delete the CSF key and add it
again providing the correct credentials.

Connect to the internet and click the offline configuration check box.
This will download the metadata for offline usage.

Unable to connect to RightNow
Cx server.

Ensure that you are connected to the internet and not blocked by or
behind the fire wall of your organization.

Error deploying the composite
on soa_server: Composite with
same revision ID already
exists.

Check if the project is already deployed on the server. Check the
overwrite composites with the same revision box or change the
revision number.

java.net.ConnectException:
Connection refused: connect;
No available router to
destination.

Ensure the SOA server is up and running.
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Understanding API Faults and Error Handling
In general, error handling in the Oracle RightNow Connect Web Services for SOAP
API is done through the standard WSDL fault mechanism. The WSDL defines three
different types of WSDL faults: RequestErrorFault, ServerErrorFault and
UnexpectedErrorFault.

The base fault type as defined by the WSDL is RNFault; an instance of RNFault
contains an exception code and message.

About Request Errors
Request errors are generated when there is a validation failure or a data related error
of the inbound request

About Server Errors
Server errors are generated when there is a known or expected error that may occur
on the server during processing of the request.

About Unexpected Errors
Unexpected errors are rare exceptions that occur unexpectedly on Oracle RightNow
Cx Server while processing a request. These unexpected errors cannot necessarily be
mapped to a specific error code or status.

Understanding RightNow Exception Codes
All three fault types, RequestErrorFault, ServerErrorFault and
UnexpectedErrorFault extend a basic RNFault, which consists of an ExceptionCode
field, which is an enumeration, and an ExceptionMessage, which is a string.

The following RightNow exception codes are defined:

• ACCESS_DENIED. Returned when a request is made to the service, but the bit to
enable Connect is not enabled on the site interface or the account profile for the
supplied credentials does not have the public SOAP bit enabled.

• INVALID_FIELD. Returned when a request is made and a field on an object in the
request does not exist or is not accessible for the given request (that is, Setting ID
on create).

• INVALID_LOGIN. Returned when a request is made but the user credentials are
invalid; this can be either username or password

• BAD_ID. Returned when an ID provided in a request is not valid.

• MISSING_ARGUMENT. Returned when a request is missing a required argument.

• BAD_ID. Returned when an ID provided in a request is not valid.

• QUERY_TIMEOUT. Returned on a query request when the specified query times out
on the server.
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• UNKNOWN_EXCEPTION. Returned when an unknown and unexpected exception occurs

Understanding Adapter Fault Handling
The Oracle RightNow adapter is a JCA adapter. As such, fault handling is similar to that in
other JCA Adapters.
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8
Oracle RightNow Adapter Use Cases

This chapter provides a walkthrough of the Oracle RightNow adapter use cases.
Each of the following use cases describes how you can use the Oracle RightNow adapter to
perform activities that integrate from SOA Suite with the Oracle RightNow Cx.

For information on the common operations that you perform before following the steps in
each of these use cases, see Performing Common JDeveloper Configuration Steps.

The Oracle RightNow adapter enables you to perform the following:

• Performing a Create, Read, Update, Destroy (CRUD) Operation on a Single Business
Object

• Performing a CRUD Operation on Multiple Business Objects

• Performing a Batch Operation with Multiple Business Objects and Multiple Operations

• Querying Arbitrary Objects using ROQL

• Performing CRUD Operations on Custom Objects

• Chaining Multiple Operations Together in One Batch Request

Performing a Create, Read, Update, Destroy (CRUD) Operation
on a Single Business Object

As part of synchronous outbound communication, the Oracle RightNow adapter connects to
the RightNow Cx instance with the help of the Connect Web Services for SOAP API to
perform a CRUD operation with a single object on the RightNow Cx instance.

This is a synchronous request response scenario, where a client requests the Oracle
RightNow adapter service to create an object in the RightNow Cx instance.

Use the Oracle RightNow adapter in the Adapter Configuration Wizard to design the
outbound service as shown in Performing Common JDeveloper Configuration Steps. These
steps begin with the Operations screen.

1. The RightNow adapter supports CRUD and ROQL operations. Choose CRUD on the
Operations screen to perform the first use case.

2. Select the Create operation on the screen. (Other CRUD options available are Read,
Update and Delete.) Click Next,

3. The Oracle RightNow adapter displays the available RightNow Cx business objects.

You can select the objects by moving an object from the Available list to the Selected
list. Use the filter option to display objects based on your criteria for better usability. The
Oracle RightNow adapter configuration wizard shows both standard and custom objects.

4. You can select processing options to perform. You can use these to enable and disable
aspects of server side processing when performing an operation. They include:

• Suppress External Events. Select this option to indicate that external events should
not run after the completion of a Create, Update or Delete operation.

8-1



• Suppress Rules. Select this option to indicate that business rules should not
run after the completion of a Create, Update or Delete operation.

For this use case, select Suppress External Events and Suppress Rules
options.

Select the Finish option, which completes the configuration of invoking
Service Cloud Service.

Upon selecting the Finish option, the wizard:

• Generates an integration-centric WSDL.

• Generates strongly typed schema definitions.

• Generates a JCA configuration file, which will have connectivity information.

• Generates reference endpoint in the SCA composite.

Performing a CRUD Operation on Multiple Business Objects
In this scenario, as part of the outbound communication, Oracle RightNow adapter
connects to the Oracle RightNow Cx instance with the help of Connect Web Services
for SOAP API to perform a create operation with multiple business objects on the
RightNow Cx instance.

This use case is a synchronous request response scenario, in which a client requests
the adapter service to create a set of objects in RightNow Cx instance.

Use the Oracle RightNow adapter to design the outbound service to work with multiple
objects.

To design an outbound service to perform CRUD operations on multiple business
objects:

1. On the Operations screen, you can select multiple business objects. To choose
multiple objects, select them under Available and move them, using the arrow to
Selected.

2. Click Next on this screen when you have completed selecting multiple objects.

The configuration wizard displays the Summary screen. The adapter also creates
a reference endpoint that enables you to wire it from other components such as
BPEL. The adapter generates the integration-centric WSDL with all batch
operations configured. The adapter also creates a reference endpoint that enables
you to wire it from other components such as BPEL.

Performing a Batch Operation with Multiple Business
Objects and Multiple Operations

In this scenario, as part of the outbound communication, the Oracle RightNow adapter
connects to the RightNow Cx instance with the help of the Connect Web Services for
SOAP API to perform a batch operation with a multiple business objects on the
RightNow Cx instance. This is a synchronous request. Follow this procedure to
perform a batch operation with multiple business objects and multiple operations:

1. Configure operation-specific details. Select the Batch Operation option on the
Operations screen.
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2. Click Add an Operation to the List to add multiple operations.

3. Select the operation type and business objects.

The configuration of a batch operation is similar to configuring a single operation (as
explained in the first use case).

The operation configuration for a batch operation also enables you to specify the batch-
only option of commit after for a given operation. This commits the entire transaction
only after the operation for which commit after is specified.

4. Click the Ok button to complete configuring operations

Querying Arbitrary Objects using ROQL
Use the Oracle RightNow adapter to design the outbound service to query Standard and
Custom objects from the RightNow Cx instance with the help of ROQL, the RightNow Query
Language.

For complete information on using the Oracle RightNow adapter to perform ROQL queries,
see Working with ROQL. After completing the common operation steps specified in 
Performing Common JDeveloper Configuration Steps, follow this procedure.

1. On the Operations screen, select ROQL from the Select an Operation Type list.

2. In the Query statement text box, input the ROQL query.

3. Test the query syntax before completing the wizard steps. Click Test My Query.

4. Once you have completed the configuration of the query operation, click Next Step. The
adapter generates the integration centric WSDL with the query operation, input and
output messages. The adapter also creates a reference endpoint which enables you to
wire it from other components such as BPEL and Mediator.

Performing CRUD Operations on Custom Objects
Oracle RightNow Cx has two different types of objects associated with it: standard business
objects and custom objects upon which you can perform CRUD operations. In this use case,
you perform a Get operation on a custom object and generate the appropriate WSDL and
JCA file.

To perform the Get operation on a custom object:

1. At the Operation screen, look under Available for the custom object you want to select
for a CRUD operation. The convention is the standard object name, for example,
Contact, followed by CustomObj (for example, Contact_CustomObj).

2. Using Contact_CustomObj as an example under Available, and using the arrow, move
the selected object to Selected.

3. Change the CRUD operation to Get to perform a Get operation on the selected object.

4. Click Next Step. The wizard displays the Summary screen.

5. Click Finish to generate the WSDL and JCA file.
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Chaining Multiple Operations Together in One Batch
Request

Chaining is an Oracle RightNow adapter feature that you can use to correlate multiple
operations within a single batch request.

Underlying concepts and resulting code for Chaining is discussed at length in 
Chaining.

The example use case for chaining discusses performing the following steps.

1. Create a Contact.

2. Create Incident (the primary Contact for this Incident is the one you created in
the first step.)

3. Get the Incident (you must return the Incident just created.)

Using Chaining shows you how to use chaining with the Oracle RightNow adapter user
interface and provides a use case for doing so. The use case shows you how you can
achieve Chaining during transformation and uses the XSLT Mapper.

Note:

Chaining is always used together with batching and does not require any
extra step in the Oracle RightNow adapter batch configuration wizard.
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9
Configuring Oracle RightNow Cloud
Properties

The Oracle RightNow Cloud Adapter enables you to create integrations with an Oracle
RightNow Cloud application.

The following sections describe the wizard pages that guide you through configuration of the
Oracle RightNow Cloud Adapter as a trigger and invoke in an integration.

Topics

• Configuring Basic Information Properties

• Configuring Oracle RightNow Cloud Source Request Properties

• Configuring Oracle RightNow Cloud Source Response Properties

• Configuring Oracle RightNow Cloud Target Operation Properties

• Reviewing Configuration Values on the Summary Page

Configuring Basic Information Properties
You can enter a name and description on the Basic Info page of each source and target
adapter in your integration.

Topics

• What You Can Do from the Basic Info Page

• What You See on the Basic Info Page

What You Can Do from the Basic Info Page
You can specify the following values on the Basic Info page. The Basic Info page is the initial
wizard page that is displayed whenever you drag an adapter to the trigger (source) or invoke
(target) area supported by your adapter.

• Specify a meaningful name.

• Specify a description of the responsibilities.
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What You See on the Basic Info Page
The following table describes the key information on the Basic Info page.

Element Description

What do you want to call your endpoint? Provide a meaningful name so that others can
understand the responsibilities of this
connection. You can include English alphabetic
characters, numbers, underscores, and
dashes in the name. You cannot include the
following:
• Blank spaces (for example, My Inbound

Connection)

• Special characters (for example,  #;83&
or righ(t)now4)

• Multibyte characters

What does this endpoint do? Enter an optional description of the
connection’s responsibilities. For example:
This connection receives an inbound
request to synchronize account
information with the cloud
application.

Configuring Oracle Cloud Adapter Connection and CSF Key
Properties

Enter the Oracle Cloud adapter configuration connectivity and Credential Store
Framework (CSF) key values for your integration.

Topics

• What You Can Do from the Oracle Cloud Adapter Connection Page

• What You See on the Oracle Cloud Adapter Connection Page

• What You Can Do from the Oracle Cloud Adapter CSF Key Page

• What You See on the Oracle Cloud Adapter CSF Key Page

What You Can Do from the Oracle Cloud Adapter Connection Page
You can specify the following connection values for the Oracle Cloud adapter.

• Specify the WSDL URL for some adapters. If you are configuring the Oracle
Eloqua Cloud adapter, no WSDL is required.

• Specify the security policy.

• Create the authentication key. A key created for one direction (for example,
outbound) is also available for selection in the other direction (for example,
inbound).

Chapter 9
Configuring Oracle Cloud Adapter Connection and CSF Key Properties

9-2



What You See on the Oracle Cloud Adapter Connection Page
The following table describes the key information on the Oracle Cloud adapter Connection
page.

Element Description

WSDL URL Note: This field is not displayed for the Oracle
Eloqua Cloud adapter.

Specify the WSDL. The WSDL is used to build
integrations specific to your instance. You can also
select the WSDL from a file system or another
source by choosing the browser icon next to the
WSDL URL field. Click File System at the top of
the dialog, then browse for the WSDL.

Security Policy Select the security policy appropriate to your
environment (for example,
USERNAME_PASSWORD_TOKEN).

• The wizard shows all policies, including those
that may not be applicable. To make a correct
selection, you must have a knowledge of
policies. For example, you cannot select a
SAML-based policy because the identity is
not propagated.

• The policies you apply to the cloud adapter
are unique to the cloud adapter and do not
impact other endpoints in the composite.

Authentication Key Select the CSF authentication key.

• Add: Click to create a new authentication key.
You must specify the key name, user name,
and password.

• Edit: Click to edit an authentication key.
• Delete: Click to delete an authentication key.

Test Click to validate the authentication key.

What You Can Do from the Oracle Cloud Adapter CSF Key Page
You can specify the following CSF key values for the Oracle Cloud adapter.

• CSF key name

• User name and password

• If you are configuring the Oracle Eloqua Cloud adapter only, you must specify a company
name.
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What You See on the Oracle Cloud Adapter CSF Key Page
The following table describes the key information on the Oracle Cloud adapter CSF
Key page.

Element Description

CSF Key Name Specify the CSF key to enable runtime
injection of credentials. The adapter uses the
CSF to retrieve the username and password
required for authentication with the application
(for example, the Oracle Sales Cloud or Oracle
ERP application). This key identifies your login
credentials during design-time.

Company Name (Oracle Eloqua Cloud
adapter only)

Note: This field is only displayed for the Oracle
Eloqua Cloud adapter.

Specify the Oracle Eloqua company name.

Email Account and Role Note: This field is only displayed for the Oracle
NetSuite Cloud adapter.

Specify the email account and role.

User Name Enter the user name for connecting to your
application (for example, the Oracle Sales
Cloud or Oracle ERP application). Your
administrator provides you with user
credentials.

Password Enter the password for connecting to your
application.

Re-enter Password Re-enter the same password a second time.

Application ID (NetSuite Adapter only) Enter the application ID. When creating a SOA
composite application, this field is optional if
you are using a NetSuite 2015 WSDL and
mandatory if using a NetSuite 2016 WSDL.

Configuring Oracle RightNow Cloud Source Request
Properties

Enter the Oracle RightNow Cloud source request values for your integration. The
values you specify start the integration.

Topics

• What You Can Do from the Oracle RightNow Cloud Source Request Page

• What You See on the Oracle RightNow Cloud Source Request Page

What You Can Do from the Oracle RightNow Cloud Source Request
Page

You can configure the following request value for Oracle RightNow Cloud.
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• Select to receive a business object as a request from the Oracle RightNow application.
This selection invokes the integration.

• Select to receive an event subscription as a request from the Oracle RightNow
application. This selection invokes the integration. Event subscriptions are supported only
if the Oracle RightNow Application version is equal to or greater than release 15.5 (May
2015). Otherwise, only business objects are supported.

Note:

The Oracle RightNow application has a limit of 20 subscriptions for every available
event subscription. For example, you can build a maximum of 20 integrations, with
all subscribing to the Customer Created Event integration and 20 integrations
subscribing to the Contact Destroy Event integration. If you create a 21st integration
for the same event subscription, this may lead to errors during integration activation.

What You See on the Oracle RightNow Cloud Source Request Page
The following table describes the key information on the Oracle RightNow Cloud source
Request page.

Element Description

Configure a Request Select the endpoint configuration option by
choosing a business object or event subscription.

• With Business Objects: Select to display a
list of business objects.

• Event Subscription: Select to display a list of
event subscriptions to which to subscribe.

Select a Business Object
(is displayed if With Business Objects is
selected)

Select the business object from the Oracle
RightNow Cloud application to receive as a
request that starts the integration.

Filter by object name
(is displayed if With Business Objects is
selected)

Enter the initial letters to filter the display of
business objects. You can also select a filter type:
• All: Displays all objects.
• Custom: Displays objects you created. These

business objects are identified by special
icons. The naming convention is a
combination of the package name and object
name joined by a “.”. For example, if there is
a custom object package called CO and an
object named PurchaseProduct, the wizard
displays the custom object as
CO.PurchaseProduct.

• Standard: Displays business objects
delivered as part of the standard Oracle
RightNow Cloud application.

Select Event
(is displayed if Event Subscription is selected)

Select the event subscription from the Oracle
RightNow Cloud application. This event is received
as a request that starts the integration.

Note: Only the Organization and Contact
business objects are supported for event
subscriptions in this release.
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Element Description

Event Name Filter
(is displayed if Event Subscription is selected)

Enter the initial letters to filter the display of
business events.

Configuring Oracle RightNow Cloud Source Response
Properties

Enter the Oracle RightNow Cloud source response values for your integration.

Topics

• What You Can Do from the Oracle RightNow Cloud Source Response Page

• What You See on the Oracle RightNow Cloud Source Response Page

What You Can Do from the Oracle RightNow Cloud Source Response
Page

You can configure the operation and business object that comprise the response type
for Oracle RightNow Cloud.

• Immediate (synchronous) response: A response business object is immediately
returned as output. You select Immediate as the response type on the Response
page and select the business object as part of the response to the client.

• No response is required: You deselect the Send checkbox on the Response page
because a response is not required.

What You See on the Oracle RightNow Cloud Source Response Page
Select the business object for the integration to send as a response document to the
Oracle RightNow Cloud application.

The following types of responses are available.

• Immediate: A synchronous response is required (See Table 9-1 for instructions)

• None: No response is required (See Table 9-2 for instructions)

The following table describes the fields available if an immediate (synchronous)
response is required.

Table 9-1    Response Type — Immediate (Synchronous) Response is Required

Element Description

Immediate Response Select Immediate for the Oracle RightNow
Cloud application to wait until a response is
received from the integration. This is also
known as the request and response message
exchange pattern. This is the default selection.
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Table 9-1    (Cont.) Response Type — Immediate (Synchronous) Response is
Required

Element Description

Also Send faults Select this checkbox if you want to send fault
information to the Oracle RightNow Cloud
application if any errors are encountered by
the integration while processing the request.
This is an optional checkbox only available
with the Immediate response type.

Object Filter Name Enter the initial letters to filter the display of
business objects. You can also select a filter
type:
• All: Displays all objects.
• Custom: Displays objects you created.

These business objects are identified by
special icons. The naming convention is a
combination of the package name and
object name joined by a “.”. For example,
if there is a custom object package called
CO and an object named
PurchaseProduct, the wizard displays
the custom object as
CO.PurchaseProduct.

• Standard: Displays business objects
delivered as part of the standard Oracle
RightNow Cloud application.

Select Business Object Select the business object for the integration to
send as a response document to the Oracle
RightNow Cloud application.

The following table describes the fields available if no response is required.

Table 9-2    Response Type — No Response is Required

Element Description

Send Deselect if a response is not required. This option
disables the selection of business objects because
none are required.

Response Type If you deselect the Send checkbox, this section is
disabled.

Select Business Object If you deselect the Send checkbox, this section is
disabled.

Configuring Oracle RightNow Cloud Target Operation Properties
Enter the Oracle RightNow Cloud target operation values for your integration.

Topics

• What You Can Do from the Oracle RightNow Cloud Target Operations Page
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• What You See on the Oracle RightNow Cloud Target Operations Page

What You Can Do from the Oracle RightNow Cloud Target Operations
Page

You can configure the following values for Oracle RightNow Cloud:

• Select to configure a single operation or multiple operations in a batch.

• Select the operation (CRUD or RightNow Object Query Language (ROQL)).

• Select the business objects.

• Enable aspects of server-side processing.

What You See on the Oracle RightNow Cloud Target Operations Page
The following table describes the key information on the Oracle RightNow Cloud target
Operations page.

Element Description

Select an Operation Mode Select the operation mode in which to define business
objects:

• Single Operation: Select to configure a single
operation.

• Batch Operation: Select to configure multiple
operations in a batch. This enables you to run
multiple operations in a defined sequence.

Selecting this option refreshes the page to display
an option for the following:
– Add an operation to the list link: Click to

create a list of batch operations and their
business objects. The operations are
performed in the order in which they appear in
the list (from top to bottom).

– Edit icon: Click to edit an operations row in the
table or change the order of batch operations.

– Delete icon: Click to delete a selected
operation row in the table.
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Element Description

Select an Operation Type Select the type of operation to perform on the business
objects in an Oracle RightNow application:

• CRUD: Represents the create, read, update,
delete, or destroy operations to perform on Oracle
RightNow business objects. Each letter maps to a
standard SQL statement, HTTP method, or DDS
operation. Select the CRUD operation to perform
on the business object: Create, Destroy, Get, or
Update.

• MISC: Represents the set of specialized tasks
operations (such as sending emails to users) to
perform in the Oracle RightNow application.

• ROQL: (RightNow Object Query Language)
enables you to define an ROQL-based query to
send as a request to perform in the Oracle
RightNow application. If you select this option, the
page is refreshed to display a field for entering a
query.

– Enter an ROQL query statement: Enter a
valid ROQL query in the field. For example:

SELECT contacts FROM organization 
WHERE name = 'RightNow'

The query can include custom fields and
parameters.

– Parameter Bindings: Displays any parameter
bindings included in the specified query. For
example, orgId is a parameter in the following
query:

SELECT Organization FROM 
Organization WHERE id = &orgId 

Enter a query with a parameter and reselect
QueryObjects from the dropdown list. This
displays a text box in which to enter a test
value for the parameter.

– Test My Query: Click to validate the query
against the Oracle RightNow application.
Query results are displayed. If errors occur,
you receive results about how to correct the
query.
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Element Description

Filter by object name Enter the initial letters of an object name to display a
range of objects. You can also select a filter type:

• All: Displays all objects.
• Custom: Displays objects you created. These

business objects are identified by special icons.
The naming convention is a combination of the
package name and object name joined by a '.'. For
example, if there is a custom object package called
CO and an object named PurchaseProduct, the
wizard displays the custom object as
CO.PurchaseProduct.

• Standard: Displays business objects delivered as
part of the Oracle RightNow application.

Select Business Objects Select a single business object or multiple business
objects from the Oracle RightNow application. The
selected operation acts upon these business objects.
The RightNow version 1.2 API is supported.

When you complete target operation configuration, the
selected operation and business objects are defined in
the integration-centric WSDL file.

Processing Options Select to enable aspects of server-side processing. By
default, no options are selected.

• Suppress External Events: Select to prevent the
Oracle RightNow application from processing any
external events raised after the completion of
create, update, or delete operations.

• Suppress Rules: Select to prevent business rules
from running after the completion of create, update,
or delete operations. Business rules are tools for
simplifying and automating common business
tasks. See the RightNow documentation for more
information.

• Suppress Response: Select to prevent the CRUD
Create operation from returning a response ID. If
this check box is disabled, the Create operation
returns an ID of the created object.

• Commit After: Select to group multiple operations
in a single transaction. At runtime, when a set of
operations in a batch is defined as part of a single
operation, the Commit After action is sent after the
last operation in that transaction boundary. When
an operation from the subset of the batch operation
fails, it is handled by throwing a fault to the client.
This option is only available with batch operations.

Reviewing Configuration Values on the Summary Page
You can review the specified adapter configuration values on the Summary page.

Topics

• What You Can Do from the Summary Page

• What You See on the Summary Page
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What You Can Do from the Summary Page
You can review source or target configuration details from the Summary page. The Summary
page is the final wizard page for each adapter after you have completed your configuration.

• View the configuration details you defined for the source or target adapter. For example,
if you have defined an inbound source adapter with a request business object and
immediate response business object, specific details about this configuration are
displayed on the Summary page.

• Click Done if you want to save your configuration details.

• Click a specific tab in the left panel or click Back to access a specific page to update your
configuration definitions.

• Click Cancel to cancel your configuration details.

What You See on the Summary Page
The following table describes the key information on the Summary page.

Element Description

Summary Displays a summary of the source or target
configuration values you defined on previous
pages of the wizard.

For adapters for which a generated XSD file is
provided, click the XSD link to view a read-only
version of the file.

To return to a previous page to update any values,
click the appropriate tab in the left panel or click
Back.
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A
Credential Store Configuration for Managing
RightNow Credentials

Before you can configure integrations against RightNow Cx using the Oracle RightNow
adapter, the authentication key that you specify at design-time has to be made available in
the credential store of the WebLogic Domain where the SOA or Service Bus Service are
deployed.

The authentication key is not automatically created within the Credential Store on deployment
of the SOA Composite or Oracle Service Bus Project. For information on how to manually
create the authentication key (also known as CSF Key) in the WebLogic Domain using Oracle
Enterprise Manager Fusion Middleware Control, see Oracle Cloud Adapters Postinstallation
Configuration Guide.
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